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1 Introduction
This manual describes a particular process. For information on certain 
products, we refer you to the manual for the product in question.

For information on how to install software, we refer you to the instruc-
tions delivered with the software.

If you discover errors and/or unclear descriptions in this manual, please 
contact your TAC representative.

1.1 Structure
The manual is divided into the following parts:

� Introduction 
The Introduction section contains information on how this manual 
is structured and how it should be used to find information in the 
most efficient way.

� Getting Started 
The Getting Started section contains a step-by-step description of 
how to engineer or carry out the tasks described in this manual.

� Reference 
The Reference section contains more comprehensive information 
about various parts of the Getting Started section. It also provides 
you with information on alternative solutions not covered by the 
Getting Started section.

Note

We are continuously improving and correcting our documentation. 
This manual may have been updated.

Please check our Docnet site at www.tac.com for the latest version.
TAC AB, Nov 2006 13 (246)
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1.2 Typographic Conventions
Throughout the manual the following specially marked texts may occur.

1.3 Prerequisites
This document is intended for users with basic computer skills includ-
ing a working knowledge of Microsoft Windows, Microsoft Word and 
Microsoft Excel. It is also beneficial that the user is familiar with using 
a web browser.

! Warning

Alerts you that failure to take, or avoid, a specific action might result 
in physical harm to you or to the hardware.

Caution

Alerts you to possible data loss, breaches of security, or other more 
serious problems.

Important

Alerts you to supplementary information that is essential to the com-
pletion of a task.

Note

Alerts you to supplementary information.

Tip

Alerts you to supplementary information that is not essential to the 
completion of the task at hand.

Advanced

Alerts you that the following information applies to complex tasks or 
tasks restricted by access.
14 (246) TAC AB, Nov 2006
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1.4 Terminology

1.4.1 Database Terminology

Term Description

Database A database is a form of digital archive for stor-
ing information. A database can have many lev-
els of information, usually in the form of a tree 
with branches, sub branches and objects.

Root A database always has a top level, also known 
as the root or root level.

Branch A branch is a sublevel of the database contain-
ing subbranches and leaves.

Examples of branches:

� A branch can be a folder that contains a 
number of subfolders and objects, where 
each subfolder contains a number of sub-
folders and or objects.

� A branch can also be a Vista Server, with a 
LonWorks network, containing a number 
of Xenta Groups and Xenta Devices, 
where each Xenta device contains applica-
tions and signals.

Folder A folder in a Vista database is a type of branch 
that can contain other folders (subfolders) and 
objects. In a previous version of Vista, folders 
were known as Logical Units, but this term is 
no longer used.

Device In a Vista database, the term Device refers to 
communication ports, networks and control 
devices (for example Xenta devices) and so on. 
A network can contain other devices, for exam-
ple group devices. A control device normally 
contains applications, modules, signals, and 
trend logs and so on. In a previous version of 
Vista, Devices were known as Physical Units, 
but this term is no longer used.

Object In a Vista database, objects can for example be; 
graphics, signals, shortcuts, reports, trend logs 
and so on. Objects may be created beneath the 
Vista Server object, devices and folders.
TAC AB, Nov 2006 15 (246)
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Shortcut A shortcut refers to another object in the Vista 
database. A shortcut called. �Temperature Set-
point� can, for example, refer to an analog 
input in a Xenta device.

� Primary Shortcut. The first shortcut cre-
ated for another object is known as the pri-
mary shortcut. It is a protected object that 
cannot be deleted without changing the 
authority settings for the object. This is to 
prevent the removal of a primary shortcut 
by mistake. 

Global objects Global objects are objects that have settings 
affecting a whole Vista system.Global objects 
are stored in the root of the Vista database and 
are visible on all Vista Servers in a Vista net-
work/system. Changes to global objects are 
communicated by the Master Vista Server 
throughout a Vista network/system.

Properties The properties refers to the properties 
(attributes) for the devices, folders and objects 
in the Vista database.

Each object has a number of properties for 
example the value of the object, the description 
of the object and so on.

The properties are displayed in a dialog box or 
a specially designed dialog box. To see the 
properties of an object, right-click the object in 
the object view and then click Properties.

� Description. This is a property that all 
objects in the Vista database has. The 
description property should be used for 
entering information describing the object.

Term Description
16 (246) TAC AB, Nov 2006
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1.4.2 Network Terms and Concepts

Term Description

Site The term Site refers to the buildings and equipment 
controlled/managed by TAC equipment/devices and 
systems, for example Xenta and Vista.

Network A network is a number of nodes forming a common 
connection.

Examples of networks:

� A LonWorks network consisting of Xenta Groups, 
Xenta Devices and LonWorks Devices.

� A computer network formed by connecting a num-
ber of computers. There are two generic types of 
computer networks:

Local Area Network (LAN). A LAN is a network 
containing a number of nodes, for example Vista serv-
ers, that are connected within a limited area. A typical 
example of a LAN is a network of computers in an 
office building. The network may vary in size from just 
a few computers to several hundred of them, depend-
ing on the kinds of transmission media used.

Wide Area Network (WAN). A WAN consists of 
computers spread over a wide area where the connec-
tions are not necessarily permanent. In fact, these often 
use dial-up connections. Several LANs may be con-
nected to a WAN using a modem, router, or the like. 
Any type of media can be used for communicating on 
this type of network.

Node This is a generic term for a connection in a network.

Examples:

� A computer in a computer network

� An Xenta device in a LonWorks network.

Computer 
or PC.

Every computer, or PC, is identified by a name. This 
computer can be the PC in your room or a server, for 
example a network server, a web server or a Vista 
Server. A computer usually forms part of a domain. 
TAC AB, Nov 2006 17 (246)
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Server The term Server can refer to server software. for exam-
ple a network server, a Vista Server or a Xenta Server. 
But often, it also refers to the computer running the 
server software.

� Vista Server. A computer running the Vista Server 
software is referred to as a Vista Server and repre-
sented by a Vista Server object in the Vista data-
base. A Vista Server object has the same name that 
the computer has in Windows. The Vista Server 
object contains the site network and devices that 
are connected to that particular Vista Server.

For example:

VistaSRV_1 (Vista Server) 
ACME_Inc (LonWorks Network) 

1ST_Floor (TAC Xenta Group) 
Conf_Room (TAC Xenta)

� Local Vista Server or Local Server.Vista Server 
is referred to as a Local Vista Server or a Local 
Server, if running on the same computer as the one 
where you are running Vista Workstation.

� Remote Vista Server or Remote Server. Vista 
Server is referred to as a Remote Vista Server or a 
Remote Server, if running on another computer 
than the one where you are running Vista Worksta-
tion.

� Master Vista Server or Master. In a Vista net-
work/system containing several Vista Servers, one 
of the Vista Servers is the Master Vista Server, 
managing and communicating system-specific 
information and global settings throughout the 
Vista network/system

� Slave Vista Server or Slave. The Slave Vista 
Servers in a Vista system receive system-specific 
information and global settings from the Master in 
the Vista network/system.

� Xenta Server. A Xenta 511/527/913 can act as a 
Xenta Server in Vista for a LonWorks network, an 
I/NET network and/or third party networks, such 
as Modbus. The Xenta Server serves Vista with all 
the information available on those networks.

Term Description
18 (246) TAC AB, Nov 2006
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Client The term Client can refer to client software, for exam-
ple a web browser, Vista Workstation, that communi-
cates with server software, for example a web server, 
or a Vista Server. But often, it also refers to the com-
puter running the client software. Other examples of 
clients are Vista Webstation and Vista ScreenMate.

� Vista Workstation. A computer running the Vista 
Workstation software is referred to as a Vista 
Workstation.

Domain Networks are usually divided into smaller areas known 
as domains. Domains contain a number of users, 
groups and computers. They are defined by the system 
managers of the network. When logging on to the net-
work, you also specify the network domain you wish to 
enter. Each domain has a domain controller, which 
supervises users logging on to the domain by checking 
that the correct password is used.

User 
Group

Users are divided into groups by system managers. 
These groups are created in order to group together 
users who are to have the same level rights and author-
ity in the network. A user can be a member of more 
than one group.

User, 
User 
Account 
or 
Account

As a user of a network or system, you receive a user 
account from the system managers of the network or 
system. A user account has a user name and a pass-
word, which are used to identify you when logging in.

Term Description
TAC AB, Nov 2006 19 (246)
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2 User Interface

2.1 The User Interface

Tip

Use the mouse to point at the image to see tooltips containing the 
names of different parts of the Vista Workstation User Interface. 

Fig. 2.1: Overview of the Vista Workstation Interface
TAC AB, Nov 2006 23 (246)
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The Taskbar in Microsoft Windows

1 Taskbar.

The taskbar is usually displayed at the bottom of the desktop in 
Windows.

The taskbar displays:

Start button. The Start button  opens the start menu 
which is used for starting programs and managing Windows.

Taskbar buttons. Each program running in Windows has a button 
on the taskbar, unless the program is running as a service.

Status area. The status area is farthest to the right of the taskbar. 
Some programs and functions in Windows display icons in the sta-
tus area.

The TAC Vista Workstation Main Window

The main window for Vista Workstation contains:

2 Title Bar. At the top a of every window, you will find the title bar. 
The title bar for Vista Workstation contains the following informa-
tion:

� Program icon. Clicking on the program icon opens the Win-
dow menu.

� Name of the Vista Server.

� Name of the user currently logged into the Vista Server.

� The standard Windows buttons.

Menu bar. The main menu for Vista Workstation is located on the 
menu bar, which is located immediately underneath the title bar.

Toolbar. Located immediately underneath the menu bar, the main 
toolbar provides access to the main features and the panes in Vista 
Workstation.

3 Workspace. The main window, in which the panes and windows 
in Vista Workstation are displayed, is viewed inside the workspace 
(gray background).

Panes. Panes are special types of windows that can be attached to the 
inner edge of the main window and hidden from view. These panes have 
their own toolbars, shortcut menus, and/or buttons.

4 The folders pane and the search pane is by default displayed as 
panes attached to left inner side of the main window.
24 (246) TAC AB, Nov 2006
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5 The following panes, are by default attached to the lower inner 
side of the main window:

� Alarms

� Disabled Alarms

� Events

� Search Result 1

� Search Result 2

6 The status watch pane is by default attached to the right inner side 
of the main window.

Windows. The windows of Vista Workstation are used to display the 
contents and objects from the Vista database.

Some of the windows have their own toolbars and shortcut menus. They 
also have the standard window buttons, for example Minimize, Maxi-
mize, Restore, and Close.

7 The following types of windows can be displayed in the main win-
dow of Vista Workstation:

� object view

� graphics

� online charts

� trend charts

� alarm view

� event view

8 Status bar. The status bar contains information about the state/
progress of the current action or request. For instance, if a dial-up 
connection is attempting to be connected, the status bar will dis-
play the current connection status.
TAC AB, Nov 2006 25 (246)
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2.2 Main Window

2.2.1 Title Bar

In the title bar, the name of the current program is displayed (that is 
Vista Workstation). The title bar also displays the user name of the per-
son currently logged into the system.

The name of the user and the computer will be displayed using the fol-
lowing format, <user name>@<computer>, for example

TAC Vista Workstation - Logged in: JOHNADAMS@PC105

In addition, the title bar also displays information about the path to the 
location in the database that you have selected, while browsing the data-
base using the folders pane or the object view.
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2.2.2 Standard Microsoft Windows Menu and Buttons

In Windows, windows can be moved and resized using the mouse. In 
every window a menu and buttons are also available, to manage the size 
of the window and to close the window/program.

The Window Menu

The Window menu is activated by clicking the program icon on the title 
bar in the upper left corner (left side of the title bar).

The Window Buttons

The Window buttons are to be found on the title bar in the upper right 
corner of a window.

Command Comment

Restore Restores a maximized window to its previous 
size.

Move Used to move the window.

Size Used to set the size of the window.

Minimize Minimizes the window, displaying only a task-
bar button on the taskbar.

For windows within Vista Workstation, a mini-
mized window is displayed on the background 
of the main window.

Maximize Maximizes the window, to the maximum size 
allowed on the desktop.

For windows within Vista Workstation, the 
window is maximized to the visible size of the 
background of the main window.

Close (ALT+F4) Closes the Vista Workstation.

For panes and windows within Vista Worksta-
tion, this command closes the window.

Next (CTRL+F6) This command will only be available if the pro-
gram has more than one window open in the 
main window. The command selects the next 
open window. 
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2.2.3 Main Menu

The menus on the main menu

The following menus are always available on the main menu:

� File

� View

� Tools

� Window � This menu is only available when one or more win-
dows are open in the main windows of Vista Workstation.

� Help

The other menus in the main menu are only available when a specific 
type of window is the active one in the main window of Vista Worksta-
tion. This applies to the following menus.

Tip

Toggling commands in the View menu:

The commands for the panes (folders, search, alarms, events, disabled 
alarms and status watch) are toggling commands.

This means that the first time you click the command for a pane, the 
pane will open. The next time you click the command, the pane will 
close.

The icons for the open panes are displayed with a frame around them, 
both in the View menu and on the main toolbar of Vista Workstation. 

Menu Active Window

Alarm View Alarm view

Event View Event view

Objects Object view

Graphics Graphic

Online Chart Online chart

Trend Chart Trend chart
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2.2.4 Customizing the Main Menu

To customize the main menu

Not all commands are displayed at the same time in the menus of Vista 
Workstation.Some commands are hidden and the most recently used 
commands are displayed first in the menus. This is in compliance with 
a feature introduced by Microsoft which limits how much is displayed 
in menus.

If you wish to see the full content of a menu, click the  button, or point 
to a menu and wait for all the remaining commands to appear.

If you want to see the full content of the menus at all times, you can 
change a setting in Vista Workstation that will enable the menus to be 
fully displayed.

To show the full contents of the menus without a delay

1 Right-click the menu bar, and then click Customize.

2 In the Customize dialog box, click the Options tab.

3 Clear Menus show recently used commands first.

4 Click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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2.2.5 Main Toolbar

The main toolbar contains some of the commands available in the main 
menu of Vista Workstation. The main toolbar is also referred to as the 
standard toolbar.

Log in

Log out

Operating / Engineering

Folders

Search

Alarms

Events

Disabled Alarms

Status Watch

Back

Forward

Cascade Windows

Tile Vertically

Tile Horizontally

Help
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2.2.6 Main Shortcut Menu

The main shortcut menu contains some of the commands available in 
the main menu of Vista Workstation.

Folders

Search

Alarms

Events

Disabled Alarms

Status Watch

Search Result 1

Search Result 2

Standard Toolbar

Customize
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2.2.7 Panes Overview

In Vista Workstation, the following windows are referred to as panes:

� Folders

� Search

� Search Result 1

� Search Result 2

� Alarms

� Events

� Disabled Alarms

� Status Watch

The panes are attached to the inner edge of the main window. They can 
be activated from the main menu, the main toolbar or the shortcut menu.

A pane can be moved from its position and attached to another edge of 
the main window. Panes attached to the edge of the main window can 
be stacked on each other, displaying a tab for each pane.

Panes can be hidden, displayed only as tabs along the edge of the main 
window. Pointing or clicking on the tab of a hidden pane displays it. 
Hiding panes provides more space for the other windows in Vista 
Workstation, for example graphics, object view and so on.

Buttons available for the panes

 / . Auto Hide. These are the buttons for hiding or unhiding 
the pane.

Close. This is the button for closing the pane.
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2.2.8 Using Panes

To move a pane

1 Grab the title bar (upper edge) of pane you wish to move, using the 
left mouse button.

2 Drag the pane to a new position at the inner edge of the main win-
dow.

To hide a pane

1 In the upper right corner of the pane, click Auto Hide .

2 The pane becomes hidden, displayed only as a tab along the inner 
edge of the main window. If the pane was stacked together with 
other panes, all the panes are hidden, displaying a tab for each 
pane.

To display a hidden pane

1 Point to or click the tab for the hidden pane, at the edge of the 
main window.

2 The hidden pane will be displayed, and when you click some-
where else it becomes hidden again.

To unhide a pane

1 Point on the tab of the hidden pane, at the edge of the main win-
dow.

2 In the upper right corner of the window, click Auto Hide .

3 The pane becomes attached to the edge of the main window. If 
there is more than one tab, all the hidden panes will be displayed 
with one tab for each one.

To close a pane

� In the upper right corner of the pane, click Close .
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2.2.9 Windows Overview

The following windows in Vista Workstation are referred to as win-
dows:

� Object View

� Graphics

� Online Charts

� Trend Charts

� Alarm View

� Event View

By default, all windows are only displayed in one instance each. If you 
choose to use the Open in New Window command, several instances of 
each type of window can be displayed at the same time.

Buttons available for the windows

Each window has its own tab. The tabs are displayed below the menu 
bar in Vista Workstation. The tabs have the following buttons:

When the windows are maximized, the following buttons appear in the 
upper right corner of the menu bar, just below the same type of buttons 
for the main window in Vista Workstation:

For displaying tabs to the left of the current tab.

For displaying tabs to the right of the current tab.

For closing the current window.

For minimizing the current window.

For restoring the windows to their previous size.

For closing the current window.
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Navigating and resizing windows

2.2.10 Status Bar

The status bar is located at the bottom of the main window of Vista 
Workstation. You can switch it on/off in the View menu, and it contains 
the following information:

� In the left corner, texts explaining commands on the main menu or 
the shortcut menus are displayed.

� In the middle, the number of matches in the most recent search 
result is displayed.

� In the right corner, information about the progress of any dial-up 
communication is displayed, using icons and text.

Tip

Alternate method of maximizing a window:

� Double-click the title bar of the window to maximize it.

Using the window tabs to navigate between windows:

� Use the arrow keys to browse the window tabs, and then click the 
tab for the window you want to see.

Using keyboard shortcuts to navigate between windows:

� To go to the next window, press CTRL+F6.

� To go to the previous window, press SHIFT+CTRL+F6
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2.3 Using the History Buttons
Vista Workstation remembers the order in which windows are opened/
selected and the main toolbar has icons for going back and forward 
through the history of the program.

To go back

� If Back  on the main toolbar is green, click Back to go one step 
back to the previously selected window or graphic.

� If Back is unavailable, then you have reached the beginning of the 
history of the program.

To go forward

� If Forward  on the main toolbar is green, click Forward to go 
one step forward to the next selected window or graphic.

� If Forward is unavailable, then you have reached the end of the 
history for of program.

Tip

You can also use the keyboard to go back and forward in the program 
history.

� To go back, press ALT+LEFT ARROW on your keyboard.

� To go forward, press ALT+RIGHT ARROW on your keyboard.
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2.4 Drag and Drop in TAC Vista Workstation
Drag and Drop means to select one or more objects/points/folders by 
holding down the left mouse button and dragging (moving) the mouse 
pointer to a target and then dropping by releasing the left mouse button.

Drag and drop can be used to move or to copy and paste folders/objects/
points.

Caution

Avoid renaming, moving or deleting objects/shortcuts in the Vista 
Database that are used/referred to by other objects/shortcuts.

Before deciding to move, rename or delete an object/shortcut, verify 
that the object/shortcut does not have any references to other objects 
that might cause a problem if you move, rename or delete the object/
shortcut.

� If you move or rename an object/shortcut included in a graphic, 
the graphic will not be able to display the value/information from 
that object/shortcut.

� If you move, rename or delete an object/shortcut used in an 
online chart, the chart will not able to display the value of the 
object/shortcut.

� If you move, rename or delete an object/shortcut used in an trend 
log, the trend log will not able to log the value of the object/
shortcut. Any trend log calculation using the trend log will fail. 
Any trend chart or Report using the trend log or a trend log cal-
culation based on the trend log, will also fail to display/report 
data.
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2.5 Keyboard Shortcuts
Vista Workstation supports the following keyboard shortcuts:

Press To

CTRL+A Select all rows in a list

CTRL+C Copy

CTRL+INSERT Copy

CTRL+drag item Copy

CTRL+X Cut

SHIFT+DELETE Cut

Drag item Move (cut and paste)

CTRL+SHIFT+V Paste as Shortcut

CTRL+SHIFT+drag item Copy and Paste as Shortcut

DELETE Delete

CTRL+E Edit

CTRL+F Search

CTRL+N New

CTRL+O Open

CTRL+SHIFT+O Open in new window

CTRL+P Print

CTRL+R References

CTRL+S Save my program settings

F1 Opens the Help

F2 Rename

F3 Search

CTRL+F4 Quit window

ALT+F4 Quit Vista Workstation

F5 Refresh

CTRL+F6 Next window

CTRL+SHIFT+F6 Previous window
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2.6 Alarm Icon on the System Tray
The status area is to be found on the right-hand side of the taskbar in 
Windows. The taskbar is usually displayed at the bottom of the desktop 
in Windows.

The status area normally displays the clock and icons for programs run-
ning in Windows. Vista Workstation displays an alarm icon  in the 
status area.

Placing the mouse pointer on the alarm icon displays a tool tip contain-
ing the name of the computer and the number of unacknowledged 
alarms in the alarms list.

To activate the alarms list from the alarm icon

� In the status area, double-click the alarm icon.

If Vista Workstation is minimized, the program will open. If the alarms 
pane is not already displayed, Vista Workstation will display it.

F9 Acknowledge alarm

F11 Full screen mode

SHIFT+F10 Activate shortcut menu

ALT+RIGHT ARROW Forward

ALT+LEFT ARROW Back

Press To

Tip

Alternate method:

� In the status area, right-click the alarm icon, and then click 
Alarms.
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2.7 Customizing the User Interface

2.7.1 Customizing Overview

The user interface of Vista Workstation can be customized to add new 
menus and toolbars, define shortcut keys, remove/re-arrange the tools 
menu and so on. To customize the user interface, use the Customize 
dialog box.

Activate the Customize dialog box, by right-clicking the menu bar and 
clicking Customize.

The Customize dialog box contains the following tabs:

� Commands. This tab is used for viewing and adding commands to 
the main menu. You can also add and remove new menus, and 
select commands from the Commands tab.

� Toolbars. This tab is used for changing and adding toolbars.

� Tools. This tab is used for defining the tools available in the tools 
menu.

� Keyboard. This tab is used for defining shortcut keys for com-
mands in Vista Workstation.

� Menu. This tab is used for the main menu and shortcut menu set-
tings.

� Options. This tab is used for displaying/hiding tooltips and/or 
shortcut key information about the toolbars, and for showing/hid-
ing commands on the main menu.

The Reset my usage data button in the Options tab, is used for reset-
ting a counter for the most commonly used commands in the menus.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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2.7.2 Choosing and Moving Columns in a List

This instruction applies to lists in the following panes and windows:

� The alarms pane and the alarm view windows

� The disabled alarms pane

� The events pane and the event view windows

� The status watch pane

� The search result 1 and search result 2 panes

� The object view window, when displayed as a detailed list.

To choose and move columns in a list

1 Right-click any column header and a dialog box is displayed.

2 In the Select Columns tab choose the columns to display by 
selecting a the columns and clicking Show or Hide. You can also 
choose columns by selecting or clearing the check mark before 
each column.

3 To rearrange the order of the columns in the list, select a column in 
the list and click Move Up or Move Down.

4 When you have finished choosing and/or rearranging columns, 
click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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Tip

You can also show/hide and move columns directly in the list using the 
mouse.

To hide columns using the mouse

1 Put the mouse pointer on the right edge of the column header. 
The mouse pointer should look like a single vertical line with 
two arrows.

2 Hold down the left mouse button and drag the column edge to 
edge of the column to the left of it.

3 Release the left mouse button and the column has been removed.

To show columns using the mouse

1 Put the mouse pointer just to the right of the right edge of a col-
umn header. If the mouse pointer looks like a double vertical line 
with two arrows, then there is a hidden column to display.

2 Hold down the left mouse button and drag to the right to display 
the hidden column.

3 Release the left mouse button and the column will be shown.

To move columns using the mouse

1 Put the mouse pointer on a column header.

2 Hold down the left mouse button and drag the column to its new 
position in the list.

3 Release the mouse button to drop it on the new position in the 
list.
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2.7.3 Creating a New Menu and Adding Commands

To create a new menu and add commands

1 Right-click the menu bar, and then click Customize.

2 In the Customize dialog box, click the Commands tab.

3 In the Categories list, click New Menu.

4 Drag the new menu from the Commands list onto the menu bar in 
the main window.

5 Add commands new menu by selecting a category in the 
Categories list and then dragging a command in the Commands 
list onto the menu you added.

2.7.4 Creating a New Toolbar and Adding Commands

To create a new toolbar and add commands

1 Right-click the menu bar, and then click Customize.

2 In the Customize dialog box, click the Toolbars tab.

3 Click New, type a name for the toolbar and then click OK.

4 Drag the new toolbar onto the menu bar in the main window.

5 Click the Commands tab and add commands to the toolbar by 
selecting a category in the Categories list and then dragging a 
command in the Commands list onto the toolbar you added.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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2.7.5 Adding a New Command to the Tools Menu

To add a new command to the Tools menu

1 Right-click the menu bar, and then click Customize.

2 In the Customize dialog box, click the Tools tab.

3 Click New (Ins) to insert a new command in the Menu contents 
list.

4 Type a name for the new command and press ENTER.

5 In the Command box, click the browse button to browse to the 
program you want to start with the new command.

6 In the Arguments box, type any arguments for the programs such 
as a file name to open with the selected program and/or parameters 
for the selected program.

7 In the Initial Directory, type the path to any directory that should 
be the initial (default) directory (folder) for the program you have 
selected.

8 Click Close.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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2.8 Program Settings for TAC Vista Workstation
Commands for Program Settings

Load My Program Settings. Loads and restores the windows, panes, 
menus, toolbars and so on in Vista Workstation, in accordance with the 
user�s most recently saved program settings.

Save My Program Settings. Saves the program settings for the cur-
rently logged in Vista User or Windows User, that is the settings for 
windows, panes, menus, toolbars and so on in Vista Workstation.

Reset Program Settings. Resets the program settings to the default set-
tings for Vista Workstation. The default settings only display the folders 
and the alarms pane. Changes made to the main menu or toolbars are 
reset to their original setting.

To save my program settings

� On the File menu, click Save My Program Settings.

To load my program settings

� On the File menu, click Load My Program Settings.

To reset program settings

� On the File menu, click Reset Program Settings.

Note

The saved program settings only apply to the logged-in user on that 
particular computer.

The next time the same user logs in on the same computer, the saved 
settings will be applied.

The save settings are also applied when selecting to load program set-
tings.
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3 Starting or Stopping TAC Vista 
Server/Workstation

3.1 TAC Vista Server/Workstation Overview
TAC Vista Server

Vista Server is the program that manages the Vista database and com-
munication with the devices and other computers in a Vista system.

From version 4.20 of Vista, it is no longer a requirement to run a copy 
of Vista Server on all the computers in a Vista system. Only computers 
connected to the devices in the system are required to run Vista Server.

Local Server � If you are running Vista Server and Vista Workstation 
on the same computer, then Vista Server is referred to as a Local Server.

Remote Server � If Vista Server is running on another computer than 
the one running Vista Workstation, it is referred to as a Remote Server.

Vista Server can run as a service in Windows.

TAC Vista Workstation

Vista Workstation is used for the day-to-day operation, engineering and 
administration of the Vista system.

From Vista version 4.20, it is no longer a requirement to run Vista 
Server and Vista Workstation on the same computer.

When logging in using Vista Workstation, you can choose to log in to a 
local server or a remote one.

It is also possible to run several copies of Vista Workstation, each copy 
logged in to a local server or a remote one.

TAC Xenta Server

Xenta Servers pages, such as graphics, trend logs, trend charts and so 
on, normally viewed with a web browser addressing a Xenta Server can 
also be viewed in Vista Workstation.

The pages are accessed in the same way as Vista Server objects.
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3.2 Starting TAC Vista Server
To start Vista Server

� On the Start menu, point to Programs, point to TAC, point to 
TAC Vista Server, and then click Server.

Vista Server starts, showing a splash screen. Then Vista Server will be 
displayed as a minimized program on the taskbar in Windows.

3.3 Stopping TAC Vista Server
To stop TAC Vista Server

1 On the File menu, click Exit.

2 In the dialog box that will be displayed, click Yes to confirm that 
you want to quit the program.

3.4 Starting TAC Vista Workstation
To start TAC Vista Workstation

� On the Start menu, point to Programs, point to TAC, and then 
click TAC Vista Workstation.

Vista Workstation starts, showing a splash screen. Then the login dialog 
box for Vista Workstation is displayed.

3.5 Stopping TAC Vista Workstation
To stop TAC Vista Workstation

� On the File menu, click Exit.
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4 Logging in and Logging out

4.1 Logging in, Logging out and Standby Mode
Logging in

When you start Vista Workstation, you are required to log in using a 
user name and a password in order to confirm your identity as a valid 
user. When you log in, you actually log in to Vista Server in order to be 
granted access to the data provided by a Vista Server. The user you are 
using in Vista Workstation grants you access to some or all of the func-
tionality of the programs, depending on the authority level of your user.

Logging out

When you log out, you confirm that you do not wish to have access to 
Vista Workstation or data from a Vista Server.

Local or remote Vista Server

Vista Server is referred to as a Local Vista Server when running on the 
same computer that you are running Vista Workstation on. If Vista 
Server is running on another computer, then Vista Server is referred to 
as a Remote Vista Server.

Vista User

This refers to using Vista User created in Vista. By default, there are 
four accounts available; User, Field, Manager and System. The admin-
istrators of the Vista system can create Vista accounts for the users of 
Vista.

Windows User

This refers to the user account that you use when logging into Windows. 
That user account can be part of one or more user groups in Windows. 
A Windows User in Vista is an object in the Vista database referring to 
a user account or a user group in Windows. This enables logging into 
Vista using a user from Windows.

The currently logged in Windows User refers to the user account you 
used when logging in to Windows on your computer.
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Standby Mode

In Standby mode, Vista Workstation data is dynamically displayed in 
graphics, online charts and so on, but the program is locked as regards 
input. There are only two buttons available to the user, Log in and Log 
Out. The user/operator is required to log in again to be able to have any 
effect on the program.

Standby Mode can be activated manually, by the user, or automatically 
by Vista Workstation when the user has been inactive for a few minutes. 
Automatic standby must be activated by the administrator, individually 
for each user.

4.2 Logging in as a Vista User

4.2.1 Logging in to a Local Vista Server (Vista User)

To log in to a local Vista Server

1 In the Log in to Vista Server dialog box, click Options to display 
other options than user name and password.

2 In the Vista Server to log in to list, click [Local Server].

3 In the User type list, click Vista User.

4 In the User name text box, type your user name.

5 In the Password text box, type your password.

6 Click OK.
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4.2.2 Logging in to a Remote Vista Server (Vista User)

To log in to a remote Vista Server

1 In the Log in to Vista Server dialog box, click Options to display 
other options than User name and Password.

2 In the Vista Server to log in to list, enter the name of the remote 
server.

3 In the User type list, click Vista User.

4 In the User name text box, type your user name.

5 In the Password text box, type your password.

6 Click OK.
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4.2.3 Changing Your Password (Vista User)

To change your password (Vista User)

1 In Vista Workstation, on the File menu, click Change Password.

2 In the Old Password box, type the password currently in use.

3 In the New Password box, type the new password.

4 In the Confirm Password box, re-type the new password.

5 Click OK.

Note

The minimum number of characters in a password is 4, and the maxi-
mum is 255.
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4.3 Logging in as a Windows User

4.3.1 Logging in to a Local Vista Server (Currently Logged-in 
Windows User)

To log in to a local Vista Server (currently logged-in 
Windows user)

1 In the Log in to TAC Vista Server dialog box, click Options to 
display other options than User name and Password.

2 In the Vista Server to log in to box, click [Local Server].

3 In the User type box, click Currently logged-in Windows user.

4 Click OK.
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4.3.2 Logging in to a Remote Vista Server (Currently Logged-in 
Windows User)

To log in to a remote Vista Server (currently logged-in 
Windows user)

1 In the Log in to Vista Server dialog box, click Options to display 
other options than User name and Password.

2 In the Vista Server to log in to box, enter the name of the remote 
server.

3 In the User type box, click Currently logged-in Windows user.

4 Click OK.
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4.3.3 Logging in to a Remote Vista Server (Windows User)

To log in to a local Vista Server

1 In the Login to TAC Vista Server dialog box, click Options to 
display other options than User name and Password.

2 In the Vista Server to log in to box, enter the name of the remote 
server.

3 In the User type box, click Windows User.

4 In the User name text box, type your user name.

5 In the Password text box, type your password.

6 Click OK.
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4.4 Logging out
To log out from TAC Vista Workstation

� On the File menu, click Log out.

4.5 Activating Standby Mode
To activate the standby mode

� On the File menu, click Standby Mode.

4.6 Change Mode
The change mode list changes the mode of Vista between Engineering 
mode (offline) and Operating mode (online).

The mode is indicated on the program icon in the Windows taskbar.

� Engineering Mode

� Operating Mode

Note

In a Vista network with several Workstations and one or several Serv-
ers, the selection Engineering/Operating mode is now (Vista 4.3.1) 
done per Vista Workstation and not, as previously, globally for the 
network. This means that setting one Workstation in Engineering 
mode will not force the others to leave the Operating mode.

If you exit Vista Workstation in Engineering mode and if you start 
Vista Workstation again, you will be prompted with �The client is set 
to Engineering mode. Change to Operating mode?�.
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5 Alarms

5.1 Alarms Overview
What is an Alarm?

In Vista, alarms are handled by alarm event objects that monitor other 
objects, for example fans or temperatures. When certain criteria relating 
to the monitored object are met, the alarm will be tripped and the alarm 
event object will change state from Normal to Alarm.

How to Notice if an Alarm has been Tripped

When an alarm is tripped, it will be displayed as an unacknowledged 
alarm in the alarms list. If the alarm buzzer has been activated, a sound 
will also be heard.

If the alarm pane is not being displayed when an alarm is tripped, it will 
automatically open to display the new alarm in the alarms list.

What to do when an Alarm has been Tripped

If your task is merely supervising the system and you are not allowed to 
acknowledge alarms, follow your employer�s instructions as regards 
how to act when an alarm is tripped.

If your task is acknowledging alarms, always investigate their cause and 
take the necessary action to deal with them before acknowledging, dis-
abling or resetting them.

In Vista Workstation, the following actions are possible:

� Acknowledge alarms.

� Disable alarms.

� Interlock alarms.

� Filter the alarms list

� View events for an alarm.

� Open linked objects.

� Print the alarms list.

� View the properties of an Alarm

In some cases, it is also possible to start an online chart and to create a 
trend log.
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Purge Alarms

You can purge an alarm in the alarms list, that is remove the alarm from 
the Vista alarm database. The alarm event in the Vista event database 
will remain.

5.1.1 Opening the Alarms Pane

To open the alarms pane

� On the View menu, click Alarms.

Tip

Alternate methods:

� On the main tool bar, click Alarms.

� On the Windows taskbar, in the status area, double-click the 
alarm icon.

� On the Windows taskbar, in the status area, right-click the alarm 
icon and then click Alarms.
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5.1.2 Alarm States in the Alarms List

The color settings for the alarm states affect all computers in a Vista sys-
tem. These are the default color settings for the different alarm states in 
Vista:

The following alarm states are available in the alarms list:

� Unacknowledged alarms. When an alarm is tripped, it will 
appear as an unacknowledged tripped alarm in the alarms list. If 
the alarm is reset before it has been acknowledged, this will be 
indicated by a  (dash) at the beginning of the row in the alarms 
list. The row will however keep its color setting.

� Acknowledged alarms. If the alarm is acknowledged, it will 
change state to an acknowledged tripped alarm in the alarms list. 
A  (check mark) at the beginning of the row also indicates that 
the row has been acknowledged. If an acknowledged alarm is 
reset, it will disappear from the alarms list.

� Reset alarm require acknowledgement. This alarm state indi-
cates that, even though the alarm has been reset, you are required 
to acknowledge the alarm in the alarms list. This alarm state will 
only be available if the administrator has activated it in the 
$System object.

� Manually disabled alarms. This alarm state indicates that the 
alarm has been manually disabled, and disabled alarms are dis-
played in the disabled alarms list.

� Interlocked alarms. This alarm state indicates that the alarm has 
been interlocked, and interlocked alarms are displayed in the dis-
abled alarms list.

Unacknowledged alarms Text color: Black.  
Background color: Red

Acknowledged alarms Text color: Black.  
Background color: Green

Reset alarm require acknowledgement Text color: Black.  
Background color: Yellow

Manually disabled alarms Text color: Black.  
Background color: White

Interlocked alarms Text color: Black.  
Background color: Gray
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5.1.3 Updating the Alarms List

To update the alarms list

1 Click the title bar of the alarms pane to make it the active pane in 
Vista Workstation.

2 Press F5 to update the alarms list.

5.1.4 Resizing Columns in the Alarms List

To resize columns in the alarms list

� In the alarms pane, right-click the alarms list and then click Resize 
Columns.

The columns will be resized to the maximum length of the content of 
each columns.

5.1.5 Acknowledging Alarms

To acknowledge alarms

1 In the alarms list, select one or more unacknowledged alarms.

2 Right-click the alarm(s) and then click Acknowledge.

Tip

Alternate method:

� Right-click the alarms list and then click Refresh.

Note

Before acknowledging an alarm, always investigate its cause and take 
the appropriate action.
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The alarms will be acknowledged one by one, and the alarms list 
updated.

Tip

Alternate methods:

� To acknowledge an alarm in the alarms list, double-click the 
unacknowledged alarm.

� In the alarms list, select one or more unacknowledged alarms. 
Press F9 to acknowledge the selected alarms.

� In the alarms list, select one or more unacknowledged alarms. On 
the alarms list toolbar, click Acknowledge.
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To acknowledge alarms using enforced acknowledge 
response

1 In the alarms list, select one or more unacknowledged alarms.

2 Right-click the alarm(s) and then click Acknowledge.

For each alarm, the Enforced Acknowledge Response dialog box 
is displayed.

3 In the Cause list, click a pre-defined cause.

4 In the Action list, click a pre-defined action.

5 In the Comment box, type an optional comment, and then click 
OK.

The alarms will be acknowledged one by one, and the alarms list 
updated.

Note

If enforced acknowledge response has been activated, the operator 
will be forced to select a cause, an action and type a comment, for each 
alarm he/she acknowledges.
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5.1.6 Opening Linked Objects

To open a linked object

� In the alarms list, right-click the desired alarm, point to Linked 
Objects and then click the linked object you want to open.

5.1.7 Viewing Events for an Alarm

To view events for an alarm

� In the alarms list, select an alarm, right-click and then click View 
Events.

Tip

Alternate methods:

� In the alarms list, click an alarm displaying the text �[Click to 
Open]� in the Linked Objects column. Click the linked object 
you wish to open.

� In the alarms list, select an alarm displaying the text �[Click to 
Open]� in the Linked Objects column. On the alarms list toolbar, 
click one of the icons to open a linked object.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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A window will open with a filter activated which only displays alarm 
events related to the alarm you selected.

To save a temporary event view as an event view object

1 Right-click the events list, and then click Save as Event View.

2 Select where to save the event view in the Vista database.

3 In the Object name box, type a name for the event view object, 
and then click Save.

The event view will be saved as an event view object in the database.
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5.1.8 Viewing the Signal Tripping the Alarm

To view the signal tripping the alarm

� In the alarms list, select an alarm, right-click and then click Signal 
Properties.

5.1.9 Filtering the Alarms List

Normally, the alarms list displays all alarms, but it can be filtered to dis-
play a subset of the alarms.

The alarms list can be filtered using one or more of the following 
options:

� Description

� Object ID

� Alarm text

� User

� Alarm priorities

� Alarm count

� Date and Time

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Important

Does not apply to Xenta alarms.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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To customize a filter for the alarms list

1 Right-click a row in the alarms list, and then click Filter.

2 In the Filter dialog box, select one or more of the possible filter 
options.

3 Click OK

The filter will be activated and the alarms list updated.

To delete an active filter and display all the alarms

� Right-click a row in the alarms list, click All Alarms.

The alarms list will be updated, displaying all alarms.

Tip

Alternate method:

� On the alarms list toolbar, click Filter.

� For more information on the filter options, click Help in the 
$AlarmView dialog box.
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5.1.10 Disabling Alarms

To disable alarms

1 In the alarms list, select one or more unacknowledged alarms.

2 Right-click the alarms list and then click Disable.

The alarm will change state to manually disabled and also appear in the 
disabled alarm list, in the disabled alarms pane.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

Before disabling an alarm, always investigate its cause and take the 
appropriate action.

Tip

Alternate method:

� In the alarms list, select one or more alarms.

� On the alarms list toolbar, click Disable.
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5.1.11 Interlocking an Alarm

Vista supports both logical and time-based interlocking of an alarm. 
Logical interlocking is controlled by a binary point, and, as long as the 
binary point is ON, the interlock will remain active.

Time-based interlocking is controlled by a manually set timer and is 
used to set a minimum time between two consecutive alarms. This is a 
way of preventing repeat alarms being generated when a fault occurs 
and is reset several times during a short period.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

Interlocking must NOT be used for dial-up devices. It is not possible 
to check interlocking in a dial-up device during an alarm as the line is 
being used by the device sending the alarm. 
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To activate logical interlocking

1 In the alarms list, select an alarm.

2 Right-click in the alarms list, and then click Alarm Properties.

3 In the General tab, click Interlock.

4 In the Logical text box, browse to the binary point you intend to 
use to control the interlock.

5 Click Select.

6 Click OK.
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To activate time-based interlocking

1 In the alarms list, right-click an alarm in the alarms list, and then 
click Alarm Properties.

2 In the General tab, click Interlock.

3 In the Disabled for box, set the number of hours and/or minutes 
you want the alarm to be interlocked.

4 Click OK.
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5.1.12 Purging an Alarm

To purge an alarm

1 In the alarms list, select one or more alarms.

2 Right-click the alarms list and then click Purge.

3 Click Yes or Yes to All to confirm purge.

The alarm(s) will be purged.

5.1.13 Printing the Alarms List

To print the alarms list

1 In the alarms list, right-click and then click Print.

2 The Windows Print dialog box will be displayed. Select a printer 
and then click OK.

The number and width of the columns will be printed as they are dis-
played on the screen.To customize the number and width of the col-
umns, see Chapter 5.1.18, �Selecting Columns in the Alarms List�, on 
page 75.

If you have activated a filter which reduces the types of alarms dis-
played or which only shows alarms for a specific object, then only the 
alarms matching the criteria for the filter you have activated will appear 
in the printed list.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

Before purging an alarm, always investigate its cause and take the 
appropriate action.

The possibility to purge alarms is restricted by access rights.

Tip

Alternate method:

1 In the alarms list, select one or more alarms.

2 On the alarm list toolbar, click Purge.

3 Click Yes or Yes to All to confirm purge.
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5.1.14 Creating an Online Chart

To create an online chart

1 In the alarms list, right-click an alarm and click Start Online 
Chart.

2 In the online chart, right-click and then click Save.

3 In the dialog box, type a file name in the File name text box and 
then click Save.

For more information see Chapter 5, �Alarms�, on page 57.

5.1.15 Creating a Trend Log

To create a trend log

1 In the alarms list, right-click an alarm, point to Create Trend Log 
and then click either Vista Server Trend Log or Xenta Trend 
Log.

2 In the Trend Log Wizard, select a suitable trend log profile and 
then click Finish.

For more information see Chapter 16, �Trend Logging�, on page 165.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

This functionality is only available to alarms referring to an object/
value displayable in an online chart.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

This functionality is only available to alarms referring to an object/
value that can be logged in a trend log.
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5.1.16 Viewing a Trend Chart for an Alarm

To view a Trend Chart from the Alarms pane

� In the alarms list, right-click an alarm, point to View Trend and 
then click the trend chart you wish to view.

A window opens displaying the trend chart you selected.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

This functionality is only available to alarms referring to an object/
value that has been logged in a trend log, and the trend log is, directly 
or indirectly, included in one or several trend charts. Trend charts 
includes logged values from trend logs or trend log calculations.
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5.1.17 Selecting Colors for the Alarms List

The colors used for the alarms (rows) in the alarms list reflect the alarm 
states. The alarms are grouped according to the alarm states, with each 
alarm state having its own color setting, for both text color and back-
ground color.

It is also possible to select which font to use or to disable the color set-
ting. The color setting is a global setting for the Vista system, that is all 
computers in a Vista system will be affected by it.

To select colors for alarms

1 In the alarms pane, right-click the alarms list and then click 
Customize.

2 In the Alarm Customization dialog box, click the Text tab.

3 Select the colors for the alarm states (font color and background 
color), and then click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

� Right-click the header of a column in the alarms list to activate 
the Alarm Customization dialog box.
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5.1.18 Selecting Columns in the Alarms List

To select columns in the alarms list

1 In the alarms pane, right-click the alarms list and then click 
Customize.

2 Click the Select Column(s) the tab.

3 Select the columns to be displayed and then click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

� Right-click the header of a column in the alarms list to activate 
the Alarm Customization dialog box.
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5.2 Disabling Alarms

5.2.1 Opening the Disabled Alarms Pane

To open the disabled alarms pane

� On the View menu, click Disabled Alarms.

Tip

Alternate method:

� On the main toolbar, click Disabled Alarms.
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5.2.2 Alarm States in the Disabled Alarms List

The color settings of the alarm states affect all computers in a Vista sys-
tem. These are the default color settings for the different alarm states in 
Vista:

The following alarm states are available in the disabled alarms list:

� Manually disabled events. This alarm state indicates that the 
alarm has been manually disabled, and disabled alarms are dis-
played in the disabled alarms list.

� Interlocked events. This alarm state indicates that the alarm has 
been interlocked, and interlocked alarms are displayed in the dis-
abled alarms list.

Manually disabled alarm events Text color: Black.  
Background color: White

Interlocked alarm events Text color:  
Black. Background color: Gray
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5.2.3 Resizing Columns in the Disabled Alarms List

To resize columns in the disabled alarms list

� In the disabled alarms pane, right-click the disabled alarms list and 
then click Resize Columns.

The columns will be resized to the maximum length of the contents of 
each columns.
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5.2.4 Enabling Disabled Alarms

To enable alarms

1 In the disabled alarms list, select one or more disabled alarms.

2 Right-click the disabled alarms list and then click Enable.

The disabled alarm is removed from the disabled alarms pane, and the 
alarm changes color in the alarms pane.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

1 In the disabled alarms list, select one or more alarms.

2 On the disabled alarms list toolbar, click Enable.
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5.2.5 Removing Interlock for an Alarm

To remove interlock

1 In the alarms list, select an alarm.

2 Right-click in the alarms list, and then click Alarm Properties.

3 In the General tab, select the Not disabled option.

4 Click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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5.2.6 Printing the Disabled Alarms List

To print the disabled alarms list

1 In the disabled alarms list, right-click and then click Print.

2 The Windows Print dialog box will be displayed. Select a printer 
and then click OK.

The columns displayed and their width will be in accordance with the 
settings of the disabled alarms list.

If you have activated a filter which reduces the types of alarms dis-
played or which only shows alarms for a specific object, then only the 
alarms matching the criteria for the filter you have activated will be dis-
played in the printed list.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.
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5.2.7 Viewing Events for a Disabled Alarm

To view events for a disabled alarm

� In the alarms list, select a disabled alarm, right-click and then click 
View Events.

A window opens, with a filter activated which only displays alarm 
events related to the disabled alarm you selected.

To save the event view

1 Right-click the events list, and then click Save as Event View.

2 Select where to save the event view in the Vista database.

3 In the File name text box, type a name for the event view, and 
then click Save.

The event view will be saved as an event view object in the database.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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5.2.8 Selecting Colors for the Disabled Alarms List

The colors used for the alarms (rows) in the disabled alarms list reflect 
the alarm states. The alarms are grouped according to the alarm states, 
with each alarm states having its own color setting, for both text color 
and background color.

It is also possible to select which font to use or to disable the color set-
ting. The color setting is a global setting for the Vista system, that is all 
computers in a Vista system will be affected by the setting.

To select colors for alarms

1 In the disabled alarms pane, right-click the disabled alarms list and 
then click Customize.

2 Click the Text tab.

3 Select the colors for the alarm states (font color and background 
color), and then click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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5.2.9 Selecting Columns in the Disabled Alarms List

To select columns in the disabled alarms list

1 In the disabled alarms pane, right-click the disabled alarms list and 
then click Customize.

2 Click the Select Column(s) tab.

3 Select the columns to be display and then click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

� Right-click the header of a column in the disabled alarms list to 
activate the Customization of Disabled Alarms dialog box.
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6 Graphics

6.1 Graphics Overview
Graphics are used to navigate a site and display information about the 
buildings, floors, systems and subsystems of the site. Graphics display-
ing systems or subsystems usually describe the process of the system 
using special symbols for fans, valves, temperature sensors and so on. 
Graphics usually also contain texts and values from the site.

When working in Operating mode in TAC Workstation, the symbols, 
texts or values in the graphics are dynamically updated with data from 
the site. Symbols may change shape or color, or start to flash to indicate 
that something is wrong, or that an alarm has been tripped.

Graphics can be linked together making it possible to navigate between 
graphics, from overview graphics, to graphics displaying information 
about a building, floor, room or system. When you click a link, you will 
move to another graphic.

6.2 Navigate Graphics
Navigation between graphics is achieved using link areas in the graphic 
which point to other graphics.

To open a linked graphic

1 In an open graphic, click the arrow icon  on the toolbar.

Tip

If the mouse pointer  passes over a link, the pointer will change to a 
pointing hand  and a tooltip will display the Vista path to the linked 
graphic.

When navigating graphics, you can also use the  and  icons on the 
main toolbar to go back and forward in the program history, displaying 
the previous or next graphic or window.
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2 Point to a link area in the graphic and then click the left mouse 
button.

The linked graphic will be displayed in the current window.

To open a linked graphic in a new window

1 In an open graphic, click the arrow icon  on the toolbar.
86 (246) TAC AB, Nov 2006
04-00022-01-en



TAC Vista Workstation, Operating Manual 6  Graphics 
2 Point to a link area in the graphic, hold down the SHIFT key and 
then click the left mouse button.

3 The linked graphic will be displayed in a new window.

.

Tip

Alternate methods:

� To open a linked graphic, place the mouse pointer over the link, 
right-click and then click Open in the shortcut menu.

� To open a linked graphic in a new window, place the mouse 
pointer over the link, right-click and then click Open in a New 
Window in the shortcut menu.
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6.3 Searching for Graphics
To search for graphics

1 In the search window, click the browse button for the Type of 
devices or objects box.

Open the Files branch and select Graphic � TGML and then click 
OK.
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2 In the Look in box, click the browse button, select a folder to 
search and then click OK. If you wish to search subunits, select 
the Include subunits option. If you want to limit the search to the 
first 1,000 items, select the Interrupt search if more than 1000 
results option. 

3 Click Search Now and view the result in Search Result 1.
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6.4 Opening a Graphic
Normally graphics are displayed in the same window. You can choose 
to open graphics (and other objects) in new windows, making it possible 
to see several graphics at the same time.

To open a graphic

1 In the folders pane, browse to the graphic you want to open.

2 In the object view, double-click the graphic to open it.

Tip

To manually update the information in an open graphic, press the F5 
key on your keyboard.

Tip

Alternate method:

� To open a linked graphic, place the mouse pointer over the link, 
right-click and then click Open in the shortcut menu.
90 (246) TAC AB, Nov 2006
04-00022-01-en



TAC Vista Workstation, Operating Manual 6  Graphics 
To open a graphic in a new window

1 In the folders pane, browse to the graphic you want to open

2 In the object view, right-click the graphic and click Open in New 
Window.

Tip

Alternate method:

� In the folders pane or in the object view, drag the graphic to the 
workspace (background) of Vista Workstation.
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6.5 Changing a Value in a Graphic

If you have the required level of authority, you will be allowed to 
change a value in a graphic.

To change a value in a graphic

1 In an open graphic, click the arrow icon  on the toolbar.

2 Point to the value you want to change in the graphic, and then 
click the value.

3 In the dialog box that appears, type a new value and click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

If the mouse pointer  passes over a value, the pointer will change to 
a pointing hand  and a light yellow tooltip will display the name and 
path of object.
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6.6 Viewing Events for a Value in a Graphic

To view events for a value in a graphic

� In an open graphic, right-click to the value and then click View 
Events.

A window will open with a filter activated which only displays events 
related to the object you selected.

To save a temporary event view as an event view object

1 Right-click the events list, and then click Save as Event View.

2 Select where to save the event view in the Vista database.

3 In the Object name text box, type a name for the event view 
object, and then click Save.

The event view will be saved as an event view object in the database.

6.7 Creating an Online Chart for a Value in a Graphic

To create an online chart for a value in a graphic

1 In an open graphic, right-click on a value, point to Start Online 
Chart and then click the value to plot.

2 In the online chart, right-click and then click Save as online 
chart.

3 In the Object name box type a object name.

4 Click Save.

For more information see Chapter 5, �Alarms�, on page 57.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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6.8 Viewing a Trend Chart for a Value in a Graphic

To view a trend chart for a value in a graphic

� In an open graphic, right-click a value and point to View Trend 
and then click the trend chart you wish to view.

A window opens displaying the trend chart you selected.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

This functionality is only available to an object/value that has been 
logged in a trend log, and the trend log is, directly or indirectly, 
included in one or several trend charts. Trend charts includes logged 
values from trend logs or trend log calculations.
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6.9 Zooming in and out of a Graphic
To zoom in

1 Right-click an open graphic and then click Zoom In, on the short-
cut menu.

2 Place the mouse pointer  over the graphic. Hold down the left 
mouse button and draw an area to zoom in on.

To zoom out

1 Right-click an open graphic and then click Zoom Out, on the 
shortcut menu.

2 Place the mouse pointer  over the graphic. Click the left mouse 
button to zoom out.

Tip

Alternate method:

� Hold down the CTRL key and roll the mouse wheel. Roll up to 
zoom in and roll down to zoom out.
TAC AB, Nov 2006 95 (246)
04-00022-01-en



6  Graphics TAC Vista Workstation, Operating Manual
6.10 Scrolling a Graphic
You will only be able to scroll a graphic, if you have zoomed in to look 
at a graphic in detail, or if the graphic is not being displayed in Zoom to 
fit mode. Scrolling means moving around in a graphic in order to see 
another part of it.

To scroll a graphic

1 Right-click an open graphic and then click Scroll on the shortcut 
menu. The mouse pointer changes to a .

2 Place the mouse pointer over the graphic. Press down the left 
mouse button to grab the graphic and move the mouse to scroll the 
graphic.

6.11 Opening an Attached Notes Object
Notes are objects that normally are simple text files, but can also be 
other types of files. Notes is opened by the program associated to that 
type of file in Windows.

Tip

Alternate methods:

� You can use the arrow keys and the Page Up/Page Down keys on 
your keyboard.

� You can place the mouse pointer anywhere in the graphic, which 
is not a link or an object, and hold down the left mouse button, to 
scroll the graphic.

Important

This function is only available for graphics of the OGC format.

In graphics of the TGML format, notes is opened using links/buttons 
in the graphic.
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To open an attached notes

1 In a graphic, right-click and the click View Notes.

2 View the notes and add additional information if necessary.

6.12 Printing a Graphic

To print a graphic

1 Right-click an open graphic and then click Print.

2 The Windows Print dialog box of will be displayed. Select a 
printer and then click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Tip

Alternate method:

� On the graphics toolbar, click View Notes.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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7 Notes

7.1 Notes Overview
A Notes object in Vista is normally a text file. Notes objects can, how-
ever, be manually defined in Vista as another type of file, for example 
an Adobe Acrobat (.pdf) file, or a Word file (.doc).

When creating or opening notes object, a copy of the file is opened by 
the tool/program in Windows that is associated with that type of file. 
Normally, Microsoft Notepad is the associated program for text files 
(.txt).

It is possible to change the setting in Windows to associate *.txt files 
with another program, if required. See the Help or other documentation 
for Windows for information about this.

If any changes are made, you must first save them in the program used 
to display/change notes. Vista will then also ask you if you wish to save 
the changed file in the Vista database.
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7.2 Opening a Notes Object
To open a notes object

1 In the folders pane, browse to the folder containing the notes 
object you want to open.

2 In the object view, double-click the notes object to open it.

The notes object are opened by the tool/program in Windows that is 
associated with that type of file.

Normally Microsoft Notepad is the associated program for text files 
(.txt).

Note

Notes can be opened from a graphic if a graphical object in the graphic 
and corresponding link for the notes object has been defined in the 
graphics editor. Notes can also be linked to an alarm and opened from 
the alarms list.
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7.3 Editing a Notes Object
To edit a notes object

1 Open the notes object.

2 Edit the file in the program used to edit the file.

3 Save the file and quit the program.

After the program used to modify the file is closed, a dialog box in 
Vista Workstation will ask you to save the notes object.

4 Click Yes to save the notes in Vista Workstation.

7.4 Printing a Notes Object

To print a notes object in Microsoft Notepad

1 On the File menu, click Print.

Note

This information concerns how to print a text file using Notepad in 
Windows. For further details, see the Windows Help or Microsoft 
Notepad.
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2 The Windows Print dialog box will be displayed. Select a printer 
and then click OK to print the notes.
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8 Hyperlink

8.1 Hyperlink Overview
Web sites can be opened in Vista Workstation and Vista Webstation by 
the use of hyperlink objects.

8.2 Opening a Hyperlink Object
To open a hyperlink object

1 In the folders pane, click the folder containing the hyperlink object 
you want to open.

2 In the object view, double-click the hyperlink object to open it.
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9 Trend Charts

9.1 Trend Charts Overview

Trend charts graphically display the logged values from one or more 
trend logs. Trend charts can support the display of values using both a 
primary and a secondary y-axis.

To update the value for a trend chart, you must manually update the 
chart, right-click the chart and then click Refresh, or press the F5 key 
on the keyboard. This will force the chart to read the trend log values 
again.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

If you update a trend chart for a Vista system that uses dial-up com-
munication, this may force the system to dial-up in order to retrieve the 
logged values.
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9.2 Creating a Trend Chart

To create a trend chart

1 In the object view, make sure that no object is selected.

2 Right-click in the object view and point to New, then point to 
Object and then click Chart � Trend.

3 Type a name for the new trend chart and press ENTER.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

It is now necessary to add trend logs to the trend chart and make any 
necessary configurations.
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9.3 Opening a Trend Chart

To open a trend chart

1 In the folders pane, browse to the folder containing the trend chart 
object you want to open.

2 In the object view, double-click the trend chart to open it.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

If you open a trend chart that does not contain any trend logs the warn-
ing message �No trend log series in chart� appears. This is normal if 
you just created the trend chart and have not yet added any trend logs 
to the chart.
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9.4 Adding Trend logs to an Open Trend Chart

To add trend logs to an open trend chart

1 On the Windows menu, click Cascade.

2 In the object view, select one or more trend logs and drag it/them 
to the trend chart.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
108 (246) TAC AB, Nov 2006
04-00022-01-en



TAC Vista Workstation, Operating Manual 9  Trend Charts 
Note

If you drop the value into the left side of the chart, the value will be 
displayed using the primary y-axis. If you drop the value on the right 
side of the chart the value will be displayed using the secondary y-axis.

Tip

Alternate methods:

� In a open trend chart, right-click and then click Edit Trend 
Chart. In the dialog box displayed, click the Trend Log tab. 
Click Add to add a trend log.

� In an open trend chart, right-click and then click Insert Trend 
Log. In the Select dialog box, find and select a trend log and then 
click Select.

� In the object view, right-click the trend chart and then click 
Properties. In the dialog box displayed, click the Trend Log tab. 
Click Add to add a value.
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9.5 Editing a Trend Chart

To edit a trend chart

1 In the folders pane, browse to the folder containing the trend chart 
object you want to edit.

2 In the object view, right-click the trend chart and then click 
Properties.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

� When a trend chart is open, click Edit Trend Chart on the 
Trend Chart menu.
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9.6 Viewing a Trend Chart

A trend chart can be displayed by double-clicking on the trend chart in 
the object view.

Trend charts can also be displayed from the alarms list, the status watch 
pane, a search result pane or a graphic. Simply right-click the object/
value, point to View Trend and click the trend chart you wish to view.

You can right-click a point/object or a trend log and find out if the 
selected object is included in any trend chart, and then select to display 
the trend chart.

To view a trend chart from the object view

1 In the folders pane, browse to the folder containing the object you 
are interested in.

2 In the object view, right-click the object, point to View Trend and 
then click the trend chart you wish to view.

To view a trend chart from the alarms pane or an alarms 
view

� In the alarms pane or alarms view, right-click the alarm, point to 
View Trend and then click the trend chart you wish to view.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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To view a trend chart from a search result pane

� In the search result pane, right-click the object, point to View 
Trend and then click the trend chart you wish to view.

To view a trend chart from the status watch pane

� In the status watch pane, right-click the object, point to View 
Trend and then click the trend chart you wish to view.
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To view a trend chart from a graphic

� In an open graphic, right-click a value and point to View Trend 
and then click the trend chart you wish to view.
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9.7 Deleting a Trend Chart

To delete a trend chart

1 In the object view, right-click the trend chart you want to delete 
and then click Delete.

2 In the dialog box displayed, click Yes to confirm.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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9.8 Printing a Trend Chart

To print a trend chart

1 Right-click an open trend chart, and click Print.

2 The Windows Print dialog box is displayed. Select a printer and 
click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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9.9 Viewing Events from Trend Chart
To view events from a Trend Chart

1 Open the trend chart you want to view.

2 Right-click the trend chart area and click View Log Events.

9.10 Viewing Estimated and Edited Values
If the communication between the logging point and the Vista Server is 
interrupted so that no values can be transferred, the values are esti-
mated.

The estimated values are marked estimated in the view log dialog box 
and they are always the same as the last logged value.

Estimated values can be modified if they differs considerably from the 
actual values. (See Section 16.11, �Edit Trend Log Values�, on 
page 181.)

To view estimated and modified values in a trend chart

1 Open the trend chart.
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2 Right-click and click Indicate Edited Values or Indicate Esti-
mated Values.

The estimated and modified values are shown in the trend chart.

The icons in the chart indicate:

Estimated values.

Edited values.
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9.11 Viewing an I/NET Trend Chart

You can view I/NET trend charts that are part of the project loaded in 
the Xenta 527, or you can browse to an I/NET point that has a trend 
sampling extension and view its trend chart. 

An I/NET point must already have a trend sampling extension in order 
for it to provide a trend chart.   If you need to add a trend sampling 
extension to an I/NET point, refer to Section 16.13.1, �Adding/opening 
an I/NET Trend Sample�, on page 184 for instructions.

To view an I/NET trend chart

1 In the folder pane, expand the Xenta 527 server and locate the  
I/NET object.

This object is a container for I/NET points, point extensions, and 
configuration objects.

2 Expand the I/NET object and its underlying branches until the 
point type portion of the desired I/NET point is visible.

Tip

Alternate method:

� Click the Indicate Edited Values or Indicate Estimated Values 
symbols in the trend chart tool bar.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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The following example shows I/NET point 55220004 DO selected 
in the folder pane. 

3 Expand the point type portion of the I/NET point to view its avail-
able HTML pages.

4 Click on the Trend Configuration page to view the point�s trend 
setup.

If necessary, you can adjust the trend setup. Refer to your I/NET 
Seven documentation for a detailed description of each parameter.
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5 Click Graph to view the point�s trend chart.
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10 Reports

10.1 Reports Overview

10.1.1 Reports

Reports are created using the report generator for Vista, which is an pro-
gram that uses Microsoft Excel. Reports are normally saved in the Vista 
database as report objects.

Reports can be saved outside of the Vista database.

Reports can be run automatically using a Periodical Report object and a 
Time Event object to determine how often to run them.

10.1.2 Report Copies

Report copies are located in the Archive subfolder at the same location 
in the Vista database as the report. The Archive subfolder will have a 
subfolder named identical to the report were the report copies are 
placed.

The report copies are named according to the date and time they were 
saved, using the syntax <YYMMDD_hhmmss>, for example 
050303_120005.

Example:

A report DatRep was opened on the 5th of May 2005 at 10:13:13 and 
saved as a copy. The a report copy is saved as 050505_101313 in the 
subfolder DatRep in the subfolder Archive.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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10.2 Opening a Report

To open a report

1 In the folders pane, browse to the report you want to open.

2 In the object view, double-click the report to open it.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate methods:

� In the object view, right-click the report and click Open. 

Note

Reports can be opened from a graphic if it has been linked using a 
command point in the graphic. Reports can also be linked to an alarm 
and opened from the alarms list.
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10.3 Opening a Report Copy

To open a report copy

1 In the object view, find the subfolder (logical unit) containing the 
report copy.

2 Double-click the report copy.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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10.4 Printing a Report

To print a report

1 Open the report. For more information on how to open a report, 
see Section 10.2, �Opening a Report�, on page 122.

2 On the File menu, click Print.

3 The Windows Print dialog box of will be displayed. Select a 
printer and then click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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11 Events

11.1 Events Overview
Vista Workstation automatically logs all events occurring in the Vista 
system. By events, we mean any action taken by the users or by the sys-
tem itself.

There are four types of events:

� Alarm. This denotes events/actions in the alarms pane or disabled 
alarms pane. Any alarms that have been tripped or any actions 
taken by the user due to alarms, for example acknowledging or 
disabling alarms and so on, are logged as events.

� Object Change. Any changes made to objects/devices in the data-
base, for example changing or renaming objects/devices, are 
logged as events.

� Command. Any commands executed by the system or a user are 
logged as events, for example logging in, logging out, creating or 
deleting objects/devices in the database and so on.

� Trend value changes. Modified values in a trend log.

Using the events pane, it is easy to obtain an overview of what has 
occurred in the system, and to track, for instance, whether a user has 
made changes to system settings which might be the cause of an alarm.

The database file is to be found in the EVLOG folder in the folder where 
Vista Workstation was installed, for example 
C:\Program Files\TAC\TAC Vista Workstation\EVLOG\TacEvlog-
File.bak.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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11.2 Opening the Events Pane
To open the events pane

� On the View menu, click Events.

Tip

Alternate methods:

� On the main tool bar, click Events.
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11.3 Refreshing the Events List
To refresh the events list

1 Click the title bar of the events pane to make it the active pane in 
Vista Workstation.

2 Press F5 to update the events list.

11.4 Resizing Columns in the Events List
To resize columns in the events list

� In the events pane, right-click the events list and then click Resize 
Columns.

The columns will be resized to the maximum length of the contents of 
each columns.

11.5 Viewing an Event in Detail
To view an event in detail

� Right-click the row (event) in the list and click Details.

Tip

Alternate methods:

� Right-click the events list and then click Refresh.
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The event will be displayed in the Event Details dialog box.

Use the buttons to browse to the previous or the next event in the list.
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11.6 Filtering Events in the Events List
Normally, the events list displays all events, but the list can be filtered 
to display a subset of the events.

To filter the events list by event type

� Right-click a row in the events list, select or clear the commands 
View Alarms, View Object Changes, View Commands and/or 
View Trendlogs to show or hide events of the selected event 
types.

The events list will be updated, displaying the events according to the 
selected event types.

To customize a filter for the events list

1 Right-click a row in the events list, and then click Filter.

2 In the Event Filter dialog box, use the options on the tabs. Select 
one or more of the possible filter options and click OK.
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The filter will be activated and the events list updated.

To delete an active filter and display all events

� Right-click a row in the events list, and click All Events.

The events list is updated, displaying all events.

Tip

Alternate method:

� On the events list toolbar, click Filter.
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11.7 Viewing Events for an Object
To view events for an object

� In the object view, right-click an object and then click View 
Events.

A window will open with a filter activated which only displays events 
related to the object you selected.

To save a temporary event view as an event view object

1 Right-click the events list, and then click Save as Event View.

2 Select where to save the event view in the Vista database.

3 In the Object name text box, type a name for the event view 
object, and then click Save.

The event view will be saved as an event view object in the database.
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11.8 Viewing Events for an Alarm
To view events for an alarm

� In the alarms list, select an alarm, right-click and then click View 
Events.

A window will open with a filter activated which only displays alarm 
events related to the alarm you selected.

To save a temporary event view as an event view object

1 Right-click the events list, and then click Save as Event View.

2 Select where to save the event view in the Vista database.

3 In the Object name text box, type a name for the event view 
object, and then click Save.

The event view will be saved as an event view object in the database.
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11.9 Finding a Text in the Events List
The Find command in the event list enables you to type a text and find 
any event containing that text. This function searches all columns, 
except the Type column.

To find a text in the events list

1 In the events list, right-click a row and then click Find.

2 In the Find dialog box, type a text in the Find what box, and click 
Find Next.

Any row in the events list that contains a text matching the one you 
typed will be selected in the list. Click Find Next to keep searching 
through the list.

11.10 Printing the Events List
To view a print preview

� In the events list, right-click a row and then click Print Preview.

In the preview, you will be able to see the layout of the printed list.

The columns displayed and their width will be in accordance with the 
settings of the event list.

If you have activated a filter which reduces the types of events displayed 
or which only shows events for a specific object, then only the events 
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matching the criteria for the filter you have activated will be displayed 
in the printed list.

To print the events

� In the events list, right-click a row and then click Print.

The Windows Print dialog box of will be displayed. Select a printer and 
then click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Tip

Alternate method:

� In print preview, click Print.
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11.11 Selecting Columns in the Events List
To select columns in the events list

1 In the events pane, right-click the events list and then click 
Customize.

2 Click the Select Columns tab.

3 Select the columns to be displayed and then click OK.

Tip

Alternate method:

� Right-click the header of a column in the events list to activate 
the Events Customization dialog box.
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12 Searching

12.1 Search Overview
Vista Workstation includes a search pane which enables you to search 
the database.

You can search the whole database from the top (root level) and all the 
branches, or you can limit your search to just one branch of the database.

When selecting criteria for searching the database, you can search 
among all the objects in the database or limit your search to specific 
types of objects or devices, for example points/signals, files and so on. 
You can also search for points/signals and set criteria for one of the 
attributes of the point/signal, for example the value attribute.

The result of the search is displayed in the search result panes. By 
default, search results are displayed in the search result 1 pane, but you 
can also choose to display them in the search result 2 pane.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Wildcard characters * and ? are allowed when typing criteria in the 
Search for devices or objects named text box, in the Look in text 
box and when searching using a string in the Description property or 
the Key property (or any other property) for devices/objects.

* � represents one or more characters

? � represents one character
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12.2 Searching for Objects/Devices
To search for an object or a device

1 On the View menu, click Search.

2 In the Search for devices or objects named text box, type the 
name of the object/device you wish to search for. You can use 
wildcard characters (* or ?) when typing criteria in this text box.

3 In the Look in text box, keep the initial setting, TAC Vista, to 
search from the top of the database. To search in a specific branch 
of the database, browse to that branch.

Select the Include subunits option to search in all subfolders/
devices below the branch you have selected, in the Look in text 
box.

4 In the Type of devices or objects text box, keep the initial setting, 
Units, Logical Objects, to choose to search all types of objects. 
To search for a one or more object types, browse to and select the 
object type(s).

5 Click Search Now to start the search.

The result of a search will be displayed in a search result pane.

Vista Workstation displays a maximum of two search result panes. To 
display the search result in the second result pane, select the Display in 
Search Result 2 option.
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If you want to limit the search to the first 1,000 items, select the Inter-
rupt search if more than 1000 results option.

To search using the property values for objects/devices

Which properties are available depend on what object types you have 
selected in the Type of devices or objects text box. If you have selected 
Points, for instance, then all properties available for analog points, 
binary points and so on, for example, will be available.

Example: Searching for a value between 1,0 and 50

This example deals with searching for points with a value between 10 
and 50.

1 Leave the Search for devices or objects named text box blank.

2 In the Look in text box, keep the initial setting, TAC Vista, to 
search from the top of the database.

3 In the Type of devices or objects text box, browse to and select 
Points.

4 In the Property value list, click Value. Select the Between option 
and type the values 10 and 50.
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5 Click Search Now to start the search.

Note

Only select the Read property value from device option, if you are 
connected to the devices and Vista is in Operation mode.
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Example: Searching for text in the description

This example deals with searching for text (a string) in a description, in 
this particular case all the objects/devices containing the text �tempera-
ture�.

1 Leave the Search for devices or objects named text box blank.

2 In the Look in text box, keep the initial setting, TAC Vista, to 
search from the top of the database.

3 In the Type of devices or objects text box, select Units, Logical 
Objects.

4 In the Property value box, select Description. Type the text 
�*temperature*� (without the double quotes).

5 Click Search Now to start the search.
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13 Status Watch

13.1 Status Watch Overview
Status watch pane is used for temporarily supervising objects/values in 
the Vista system.

Objects/Values can easily been dragged to status watch pane from the 
object view, a graphic, search result 1 or search result 2.

13.2 Adding Objects/Values to the Status Watch Pane
To add an object/value from a graphic

� In an open graphic, point and drag a value from the graphic and 
drop it into the status watch list in the status watch pane.

To add objects/values from the object view

� In the object view, select one or more objects/values, drag them 
from the object view and drop them into the status watch list in the 
status watch pane.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Alternate method:

� In the status watch list, right-click and then click Insert. Browse 
through the database. Select one or more objects/values and then 
click Open.
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To add objects/values from Search Result 1 or Search Result 
2

� In search result 1 or search result 2, select one or more objects/val-
ues, drag them from the search result and drop them into the status 
watch list in the status watch pane.

The objects/values will be added to the status watch list and automati-
cally activated to display their value.
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13.3 Deactivating/Activating Values in the Status 
Watch Pane

In front of each object/value displayed in status watch, there is an option 
(check box). If the option is selected, the value will be updated. If the 
option is not selected, the value will not be updated.

To deactivate objects/values in the status watch pane

� For each object/value in the status watch pane you do not want to 
see an updated value, clear the option in front of each object.

To activate objects/values in the status watch pane

� For each object/value in status watch pane that you want to see an 
updated value for, select the option in front of the object.
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13.4 Creating Online Chart
To create an online chart

1 In the status watch pane, right-click an object (row) and then click 
Start Online Chart.

2 In the online chart, right-click and then click Save as online 
chart.

3 In the Select dialog box, type a file name in the Object name text 
box and click Save.
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13.5 Using the Create Trend Log Wizard
For more information see Chapter 16.2, �Creating Vista Server Trend 
Logs Using the Create Trend Log Wizard�, on page 167.

13.6 Viewing a Trend Chart

To view a trend chart from the status watch pane

1 In the status watch pane, right-click an object (row), point to View 
Trend Chart and then click the trend chart you wish to view.

A window opens displaying the trend chart you selected.

Note

This functionality is only available to an object/value that has been 
logged in a trend log, and the trend log is, directly or indirectly, 
included in one or several trend charts. Trend charts includes logged 
values from trend logs or trend log calculations.
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13.7 Removing Objects/Values from the Status Watch 
Pane

To remove objects/values from the status watch pane

1 Select one or more objects (rows) in the status watch pane.

2 Right-click and then click Remove.

Note

Removing objects/values from the status watch pane will not remove 
them from the database, it will only remove them from the status 
watch pane. 
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14 Viewing/Changing Values

14.1 Viewing/Changing Values Overview
To view values in TAC Vista Workstation

Values are displayed in:

� Graphics

� The object view in detailed view, displaying the value column.

� The status watch.

� The properties dialog box of each object.

The value displayed will depend on which mode Vista Workstation is 
operating in:

� Engineering Mode. This mode is used when working offline. Val-
ues displayed in Vista Workstation will be read from the Vista 
database.

Exception: For values that are updated by Vista when the corre-
sponding device is online (dynamic values in pictures, in the Object 
window, and in the Status Watch and Search Results panes), the 
online values will still be displayed.

� Operating Mode. This mode is used when working online. Values 
displayed in Vista Workstation will be read from the devices con-
taining the values.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

In a Vista network with several Workstations and one or several Serv-
ers, the selection Engineering/Operating mode is now (Vista 4.31) 
done per Vista Workstation and not, as previously, globally for the 
network. This means that setting one Workstation in Engineering 
mode will not force the others to leave the Operating mode.
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To change values in TAC Vista Workstation

Changing the value of an object can be performed in:

� Graphics

� The object view in detailed view, displaying the value column.

� The status watch.

� The properties dialog box of each object.

All commands performed on objects, that is creating objects, changing 
the value of an object, deleting objects and so on, are logged as events 
in the events list.

Electronic Signature when Changing a Value

If the electronic signature has been activated and applied to the object 
in question, you will have to type a user name, a password, selecting a 
cause for changing the value of the object. An optional comment can 
also be typed.

Changing a value in a dial-up system will cause a dial-up connection to 
activated to change the value of the device.

14.2 Viewing Values in the Object View

To view values in the object view

1 In the folders pane, browse to the point/value/shortcut you wish to 
change.

Note

Choosing to display the values column in the object view will cause 
Vista Workstation (in Operating mode) to try to retrieve the current 
values.

When using a dial-up system, this will cause Vista Workstation to dial 
the devices in order to retrieve the values.
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2 In the object view, right-click (but not on an object), point to View 
and then click Details to make sure that object are displayed in 
detailed view.

3 Right-click the column header of the detailed view. Select the 
Value column and then click OK.
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14.3 Selecting Columns in the Object View
To select columns in the object view

1 In the object view, right-click the header for the columns.

2 In the Select Columns tab, select the columns to be displayed and 
then click OK.
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14.4 Changing a Value in the Object View
To change a value in the object view

1 In the object view, click the value of the object you wish to 
change.

2 Type a new value and press ENTER.

Note

To be able to change a value in the object view, you must use the 
detailed view and choose to display the Value column.

Tip

Alternate method:

� Right-click an object and then click Properties. In the 
Properties dialog box, type a new value and then click OK.
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14.5 Enter an Electronic Signature when Changing a 
Value

To enter an electronic signature when changing a value

1 When the electronic signature is activated, changing a value will 
cause the Enter Electronic Signature dialog box is displayed.

2 In the Username text box, type the domain and user name for your 
user account, according to the syntax <domain>\<user name>, for 
example Vistadomain\john.

3 In the Password text box, type the password for your user 
account.

4 In the Cause text box. choose a pre-defined cause.

5 In the Comment text box, type an optional comment, and then 
click OK.

Note

If the Electronic Signature has been activated and applied to the object 
in question, you will have to type a user name, a password, selecting a 
cause for changing the value of the object. An optional comment can 
also be typed.

Changing a value in a dial-up system will cause a dial-up connection 
to activated to change the value of the device.
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14.6 Viewing Values in the Status Watch Pane

To view a value in the status watch pane

� In the object view, or in a search result pane, select one or more 
objects and drag them to the status watch pane.

Note

Selecting to display the values by dragging objects to the status watch 
pane, will cause Vista Workstation (in operating mode) to try to 
retrieve the current values.

When using dial-up system, this will cause Vista Workstation to dial 
the devices in order to retrieve the values.

Tip

By default, the Value column is displayed in the status watch pane. If 
the Value column is not being displayed, right-click the column 
header, choose to display the Value column, and click OK.
TAC AB, Nov 2006 155 (246)
04-00022-01-en



14  Viewing/Changing Values TAC Vista Workstation, Operating Manual
14.7 Changing a Value in the Status Watch Pane
To change a value in the status watch pane

1 In the status watch pane, look in the Value column and click the 
value of the object you wish to change.

2 Type a new value and press ENTER.

14.8 Xenta Server Pages Overview
A Xenta Server can provide the following pages which can be access by 
clicking the follwong objects in Vista Workstation:

� Xenta Server Url � Graphic,

� Xenta Server Url � Values,

� Xenta Server Url � Events,

� Xenta Server Url � Alarms,

� Xenta Server Url � Trend log,

� Xenta Server Url � HTML

� Xenta Server Url � Time Object

14.8.1 Help for the Xenta Server Pages

When a Xenta Server page is displayed the graphical user interface from 
the Xenta Server web site is used. Thus, the Help accessible from the 
toolbar on the Xenta Server page is that of the Xenta Server web site, 
not the Vista Workstation Help.

When the Help button is clicked you will be informed how to download 
and view the help pages. Follow the instructions.

Tip

Alternate method:

� Right-click an object and then click Properties. In the 
Properties dialog box, type a new value and then click OK.
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15 Online Charts

15.1 Online Charts Overview
Online charts graphically display the current value of one or more 
objects/values in the Vista database. Online charts can support the dis-
play of values using both a primary and a secondary y-axis.

By default, an online chart displays up to 86,400 values and updates the 
chart every 2 seconds. This is a setting that can be done for each chart, 
by right-clicking the chart and then clicking Edit Online Chart.

After displaying the number of values that the online chart is set to do, 
it will stop displaying values. To get the online chart to start displaying 
a new set of values, right-click and then click Clear, or press F5 on the 
keyboard.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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15.2 Creating an Online Chart
To create an online chart

1 In the object view, select one or more points or shortcuts, right-
click and then click Start Online Chart.

2 In the online chart, right-click and then click Save as online 
chart.
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3 In the Select dialog box, type a file name in the Object name text 
box and then click Save.

15.3 Opening an Online Chart
To open an online chart

1 In the folders pane, browse to find the online chart you wish to 
open. The object view displays the content of the folders pane.

2 In the object view, double-click the online chart to open it.
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15.4 Adding Values to an Open Online Chart
To add values to an open online chart

1 On the Windows menu, click Cascade.

2 In the object view, select one or more points or shortcuts and drag 
them to the online chart.

Note

If you drop the value into the left side of the chart, the value will be 
displayed using the primary y-axis. If you drop the value into the right 
side of the chart, the value will be displayed using the secondary y-
axis.
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Tip

Alternate methods:

� In an open online chart, right-click and then click Edit Online 
Chart. In the dialog box displayed, click the Online Charts tab. 
Click Add to add a value.

� In an open online chart, right-click and then click Insert a new 
series. In the Select dialog box, find and select a value and then 
click Select.

� In the object view, right-click the online chart and then click 
Properties. In the dialog box displayed, click the Online Charts 
tab. Click Add to add a value.
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15.5 Editing an Online Chart
To edit an online chart

1 In the folders pane, browse to find the online chart you wish to 
modify. The object view displays the content of the folders pane.

2 In the object view, right-click the online chart and then click 
Properties.
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15.6 Deleting an Online Chart
To delete an Online Chart

1 In the object view, right-click the online chart you wish to delete 
and then click Delete.

2 In the dialog box, click Yes to confirm.
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15.7 Printing an Online Chart
To print an online chart

1 Right-click an open online chart, and then click Print.

2 The Windows Print dialog box of will be displayed. Select a 
printer and then click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.
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16 Trend Logging

16.1 Trend Logging Overview

16.1.1 Trend Logging

Trend logging is used to store measured values from a site, for example 
a carbon dioxide meter in an office, an outdoor thermometer, the energy 
usage from an energy meter and so on.

Trend logging can be used for a limited time only to help adjusting a 
system or a process, or, on a permanent basis, to store logged data for 
reporting for example energy usage.

The �Create trend log� wizards in Vista is used to set up trend logs and 
displaying them in trend charts.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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16.1.2 The Trend Log Wizards

The trend log wizards are used to simplify logging and displaying data 
in Vista Workstation.

The trend log wizards use pre-defined trend log profiles to assist in cre-
ating various types of trend logs.

Each trend log profile:

� Creates one trend log object.

� Can create four different types of trend log calculation; one per 
day, one per week, one per month and/or one per year. The trend 
log calculation objects can either be a sum or an average of the 
values from the trend log object.

� Can create a trend chart. It is also possible to reuse an existing 
trend chart. The trend chart can display values from the trend log 
objects or from the trend log calculation objects.

You can use the settings made by the trend log profile you have selected 
as they are, or you can make changes before finishing the wizard.

Fig. 16.1: Schematic view of a trend log wizard in Vista
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16.2 Creating Vista Server Trend Logs Using the Create 
Trend Log Wizard

To create a Vista Server trend log using the wizard

1 In the object view, alarms, status watch or a graphic, right-click 
the object/value/shortcut you want to log, point to Create Trend 
Log, then click Vista Server Trend Log

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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2 On the Welcome to the Create Trend Log Wizard page.

If you do not wish to see the welcome page again, select the Do not 
show this information page again option. 

3 Click Next.

4 On the Trend Log Profile page, select one of the predefined trend 
log profiles suitable for the type of object/value you have selected 
to log.

If you are familiar with the selected profile, click Finish. The wiz-
ard will create a trend log, a trend log calculation object and/or 
trend chart, that corresponds to the settings of the selected trend log 
profile.

5 If you are not familiar with the trend log profile you have selected, 
click Next to view the settings suggested for that profile.
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On the Trend Log Parameters page, you can view/change the log 
point, the path for saving the trend log object in the Vista database, 
and the name of the trend log object.

6 Click Next to continue.

On the Trend Log Profile page, you can view/change the settings 
for the trend log.

7 Click Next to continue.
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On the Trend Log Calculation page, you can view/change a trend 
log calculation object and decide if you want to use it.

8 Click Next to continue.

On the Trend Chart page, you can view/change the settings of the 
trend chart.

9 Click Next to continue.

10 On the Completing the Create Trend Log Wizard page, click 
Finish to create the objects in accordance with the selections you 
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made in the wizard, or click Cancel to quit the wizard without cre-
ating any objects.

Note

� By default, trend logs, trend log calculation objects and/or trend 
charts are named after the selected log point and stored in the 
same location as the log point in the database.

� After you have clicked Finish in the wizard, Vista Workstation 
will verify if the program is in Operating mode. If that is not the 
case, a message asks you if you want to activate Operating mode. 
Click Yes to go to Operating mode and finish the wizard.
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16.3 Creating Xenta Trend Logs Using the Create Trend 
Log Wizard

To create a Xenta trend log using the wizard

1 In the object view, alarms, status watch or a graphic, right-click 
the object/value/shortcut you want to log, point to Create Trend 
Log, then click Xenta Trend Log

2 On the Welcome to the Create Xenta Trend Log Wizard page.

If you do not wish to see the welcome page again, select the Do not 
show this information page again option.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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3 Click Next.

4 On the Xenta Trend Log Profile page, select one of the pre-
defined trend log profile that is suitable for the type of object/
value you have decided to log.

If you are familiar with the selected profile, click Finish. The wiz-
ard will create a trend log, a trend log calculation object and/or 
trend chart, according to the settings of the selected trend log pro-
file.

5 If you are not familiar with the trend log profile you have selected, 
click Next to view the settings suggested for that profile.

On the Xenta Trend Log Parameters page, you can view/change 
the log point, the path for saving the trend log object in the Vista 
database, and the name of the trend log object.

6 Click Next to continue.
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On the Xenta Trend Log Profile page, you can view/change the 
settings for the trend log.

7 Click Next to continue.

On the Trend Log Calculation page, you can view/change a trend 
log calculation object and decide if you want to use it.

8 Click Next to continue.

On the Trend Chart page, you can view/change the settings of the 
trend chart.

9 Click Next to continue.
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10 On the Completing the Create Trend Log Wizard page, click 
Finish to create the objects in accordance with the selections you 
made in the wizard, or click Cancel to quit the wizard without cre-
ating any objects.

Note

� By default, trend logs, trend log calculation objects and/or trend 
charts are named after the selected log point and stored in the 
same location as the log point in the database.

� After you have clicked Finish in the wizard, Vista Workstation 
will verify if the program is in Operating mode. If that is not the 
case, a message asks you if you want to activate Operating mode. 
Click Yes to go to Operating mode and finish the wizard.
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16.4 Trend Log Profiles

16.4.1 Using the Trend Log Profiles

The trend log wizard uses a number of predefined log profiles; they are 
suitable for logging different types of objects/values and can display 
them in an online chart. All the trend log profiles use the same measure-
ment unit as the point/object you have select to log in a trend log.

The following default profiles are available:

� Temperature per hour

� Average Temperature per day

� Heating per 24 hours (before midnight)

� Heating per 24 hours (after midnight)

� Electricity per hour

� Electricity per 24 hours (before midnight)

� Electricity per 24 hours (after midnight)

� Water per 24 hours (before midnight)

� Water per 24 hours (after midnight)

� Carbon Dioxide (CO2) every 10 minutes

� Log a generic value every 10 minutes

For detailed information on each trend log profile, see Chapter 20, 
�Trend Log Profiles�, on page 227.

16.5 Viewing a Trend Chart

For detailed information on how to view a trend chart, see Chapter 9.6, 
�Viewing a Trend Chart�, on page 111.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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16.6 Viewing Logged Values in a Trend Log as a Table

To view logged values in a trend log as a table

1 In the object view, right-click a trend log and click View Log.

2 When you have finished viewing the values in the log values dia-
log box, click the Close button. 

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

If Vista Workstation is in Operating mode and the trend log being used 
stores logged values in a device, then Vista will connect to the device 
in order to retrieve the most recent logged values.

If Vista Workstation is in Engineering mode, the logged values will be 
retrieved from the Vista database.

If you view a Xenta Server trend log in Vista Workstation that is Man-
Off, Vista will not connect to the Xenta Server in order to retrieve the 
most recent logged values, but only read values archived in Vista.

Tip

The View Log dialog box will normally only show the 1,000 most 
recently logged values in a trend log. The value of how many logged 
values to display is set individually for each trend log object.

You can override this setting and display all the values in a trend log 
by holding down the SHIFT key on the keyboard while clicking on 
View Log. 
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16.7 Viewing Logged Values in a Trend Chart

To view logged values in a trend chart

1 Right-click the log for which you want to view the trend chart.

2 Point to View Trend, and then click one of the available trend(s). 
A trailing �(chart)� indicates that the trend chart is a Vista Work-
station trend chart.

16.8 Viewing Logged Values in a Trend Page

To view logged values in a trend page

1 Right-click the log for which you want to view the trend page.

2 Point to View Trend, and then click one of the available trend(s). 
A trailing �(page)� indicates that the trend is a Xenta Server trend 
page.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

If Vista Workstation is in Operating mode and the trend log being used 
stores logged values in a device, then Vista will connect to the device 
in order to retrieve the most recent logged values.

If Vista Workstation is in Engineering mode, the logged values will be 
retrieved from the Vista database.

If you view a Xenta Server trend log in Vista Workstation that is Man-
Off, Vista will not connect to the Xenta Server in order to retrieve the 
most recent logged values, but only read values archived in Vista.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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16.9 Copying Trend Log Values to Microsoft Excel

To copy/paste trend log values to Microsoft Excel

1 In the object view, right-click a trend log and click View Log.

2 In the log values dialog box, right-click and then click Copy.

3 Start Microsoft Excel. Select the A1 cell in an empty spreadsheet, 
right-click and then click Paste.

The values will be pasted into three columns, Date, Value and Origin.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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16.10 Printing Trend Log Values

To print logged values

1 In the object view, right-click a trend log and click View Log.

2 In the log values dialog box, click Print.

3 The Windows Print dialog box will be displayed. Select a printer 
and then click OK.

The paper size and orientation (portrait or landscape) are defined in the 
properties of the Windows Print dialog box.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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16.11 Editing Trend Log Values
To edit a value

1 Right-click the trend log object you want to modify.

2 Select View Log.

3 Select the values you want to change.

4 Right-click and click Edit.

5 Change the value.

6 In the Edit dialog box, choose Just change the edited item if you 
just want to change one value. Choose Change all selected items 
if you want to change all selected items.

7 Click OK.

The modified values are now marked Edited.

All changed values are recorded in the event log and are easily checked.
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16.12 Checking Edited Trend Log Values
1 Right-click the trend log object and select View Events.

2 In the events list, click Filter.

3 Ensure that only Trend value changes is selected.

4 Click OK.
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5 In the events list, right-click the event you want to check and click 
Details.

6 The Event Details dialog shows the time of the editing, the old 
value and the new value.
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16.13 I/NET Trend Samples

Assign a Trend Sampling extension to an I/NET point if you want to 
collect data to be used in a graph or printed in a report. This extension 
is available with all I/NET point types.

16.13.1 Adding/opening an I/NET Trend Sample

To add/open an I/NET trend sample

1 In the folder pane, expand the Xenta 527 server and locate the  
I/NET object.

This object is a container for I/NET points, point extensions, and 
configuration objects.

2 Expand the I/NET object and its underlying branches until the 
point type portion of the desired I/NET point is visible.

The following example shows I/NET point 55220004 DO selected 
in the folder pane. 

3 Expand the point type portion of the I/NET point to view its avail-
able HTML pages.

4 Click on the Trend Configuration page to view the point�s trend 
setup.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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If the selected I/NET point already has a trend sample extension, 
the trend configuration page opens.

5 If the selected I/NET point does not already have a trend sample 
extension, you will be presented with a message asking if you 
would like to add the extension now.

Confirm that you wish to add the trend by clicking Yes. The trend 
configuration page opens.
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16.13.2 Editing an I/NET Trend Sample

To edit an I/NET trend sample

1 From the open trend setup editor, use the available parameters to 
configure the I/NET trend. If necessary, refer to your I/NET Seven 
documentation for a detailed description of each parameter.

2 Click Save to save your settings.

3 At any time while working in the trend setup editor, you can click 
Graph to view the point�s trend chart.

16.13.3 Deleting an I/NET Trend Sample

To delete an I/NET trend sample

1 From the open trend setup editor, click Delete.

2 Confirm that you wish to delete the trend by clicking OK. 
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17 Time Functions

17.1 Time Charts Overview
Three types of time charts are available in Vista:

� Global Time Charts. This type of object (Time Chart � Global) 
can only be created in the top (root) level of the Vista database. 
Time charts of this type are visible and can be used on all comput-
ers in a Vista system.

� Local Time Charts. This type of object (Time Chart � Local) can 
be created in folders below the top (root) level of the Vista data-
base. Time charts of this type are only visible on the computer 
they have been created on.

� TAC Xenta Time Charts. This object type (Time Chart � TAC 
Xenta) is created in Menta, while programming an application for 
the Xenta device. This type of time chart can be modified in Vista 
Workstation.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

A Xenta time chart can be replaced by a central time chart.

A central time chart is a time chart created in Vista Workstation, that 
is a global time chart or a local time chart.

We recommend that you use a global time chart when replacing a 
Xenta time chart. 

It is possible to specify time intervals over the midnight hour. 

All alternative events will appear with a bold date in the calendar.
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17.2 Time Charts

17.2.1 Opening a Time Chart

To open a time chart

1 In the folders pane, navigate to the time chart you wish to open. 
The object View will display the content of the folders pane.

2 In the object view, double-click the time chart to open it.
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17.2.2 Overviewing a Time Chart

� To get an overview of all time events, click All Events.

Note

Alternative Charts are shown with From and To dates (yearly alterna-
tive events appear with the year shown as �****�). Weekly events lack 
the From and To dates.
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17.2.3 Adding an Event in a Time Chart

To add an event to a time chart

1 In the time chart window, point to the time when you want the new 
event to start. Hold down the left mouse button and draw an area 
representing the time period for the new event.

2 Click New.

3 If necessary, modify the settings for the event and click OK.

.

Tip

Alternate method:

� Hold down the left mouse button and draw an area representing 
the time period for the new time event. Right-click, and click 
New. If necessary, modify the settings for the event and click 
OK. 
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17.2.4 Editing an Event in a Time Chart

To edit an event in a time chart

1 Double-click the event you wish to modify.

2 Modify the settings for the event and then click OK.

Tip

Alternate methods:

� Click the event you wish to modify and click Edit. Modify the 
settings for the time event and click OK.

� Click the event you wish to modify. Right-click the event and 
click Edit. Modify the settings for the time event and click OK.
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17.2.5 Deleting an Event in a Time Chart

To delete an event in a time chart

1 In the time chart window, click the event you wish to delete.

2 Click Delete.

3 Click Yes to delete the event.

Tip

Alternate method:

� Click the time event you wish to delete. Right-click the event and 
click Delete. Click Yes to delete the time event. 
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17.3 TAC Xenta Time Charts

17.3.1 Opening a TAC Xenta Time Chart

To open a TAC Xenta time chart

1 In the folders pane, browse to the Xenta time chart you wish to 
open.

2 In the object view, double-click the Xenta time chart to open it.

Note

Xenta time charts are located in the application modules of the Xenta 
devices.

The Xenta devices are located in the networks below the Operator 
Unit.
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17.3.2 Adding an Event in a TAC Xenta Time Chart

To add an event to a TAC Xenta time chart

1 In the time chart window, point to the time when you want the new 
time event to start. Hold down the left mouse button and draw an 
area representing the time period for the new event.

2 Click New.

3 If necessary, modify the settings for the event and click OK.

Tip

Alternate method:

� Hold down the left mouse button and draw an area representing 
the time period for the new event. Right-click, and click New. If 
necessary, modify the settings for the event and click OK. 
194 (246) TAC AB, Nov 2006
04-00022-01-en



TAC Vista Workstation, Operating Manual 17  Time Functions 
17.3.3 Editing an Event in a TAC Xenta Time Chart

To edit an event in a TAC Xenta time chart

1 Double-click the event you wish to modify.

2 Modify the settings for the event and then click OK.

Tip

Alternate methods:

� Click the event you wish to modify and click Edit. Modify the 
settings for the event and click OK.

� Click the event you wish to modify. Right-click the event and 
click Edit. Modify the settings for the event and click OK. 
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17.3.4 Deleting an Event in a TAC Xenta Time Chart

To delete an event in a TAC Xenta time chart

1 In the time chart window, click the event you wish to delete.

2 Click Delete.

3 Click Yes to delete the event.

Tip

Alternate method:

� Click the event you wish to delete. Right-click the event and 
click Delete. Click Yes to delete the event. 
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17.3.5 Replacing a TAC Xenta Time Chart with a Central Time Chart

You can replace a weekly chart, and/or an alternative Xenta chart for a 
Xenta device, with time charts created in Vista Workstation.

To replace a TAC Xenta Time Chart with a Central Time 
Chart

1 Open the Xenta time chart.

2 Click the Central Time Charts tab.

3 To replace the weekly time chart, browse to a time chart in Vista in 
the Week Chart text box.

4 To replace the alternative time chart, browse to a time chart in 
Vista in the Alternative Chart text box.

5 Click OK.

Note

If an event in an alternative Xenta chart is defined for a specific date, 
then all normal week chart events for that date will be void.
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17.4 I/NET Time Schedule

17.4.1 I/NET Time Schedule

I/NET Time Schedule Types

Three types of I/NET Time Schedules are available in Vista:

� Master � Can be used as a base schedule for several points.

� Slave � Follows a specific master schedule, but allows you to 
define an offset period for each action or to even ignore the action 
entirely.

� Independent � Used only for a particular point. Its control deci-
sions are not based on the schedule of any other point.

If an I/NET Time Schedule is opened by double-clicking it in the object 
view or opened from a color graphic, Vista will display the I/NET time 
schedule editor.

Using the I/NET time schedule editor, it is possible to define a schedule 
for a specific DC or DO point currently residing in a controller, for any 
day of the week.

I/NET Time Schedule

Each time schedule allows 17 entries (actions/times) to be added for 
each DC or DO point. Schedule actions can be entered in random order, 
with no attention paid to the chronological order of events. When you 
exit from the schedule, the controller rearranges the actions into chro-
nological order for independent schedules. Master and slave schedule 
actions will remain in the order in which they were entered.

Each of the schedule types (Master, Slave, and Independent) also allows 
you to enter actions and times for alternate schedules (Temporary and 
Special Day schedules).
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Example:

Modifying an independent time schedule.

1 From the I/NET Time Schedule Editor, click a blank entry line 
and then click the Add button. The Time Schedule Action Editor 
appears.

2 Select the appropriate action (for example Start).

3 Enter the appropriate time (24-hour format only).

4 Define the time schedule:

� If the entry is to be applied as a normal time schedule, select 
the days when the action is to be applied.

� If the entry is to be applied as an alternate schedule and you 
want it to recur each year (that is a standard holiday sched-
ule), then select the Special Day schedule that is to be applied 
for that action.

� If the entry is to be applied as an alternate schedule during the 
current week, then select the Temporary schedule that is to be 
applied for that action

5 Click OK.

Note

Special Day schedules for specific dates should be pre-defined using 
the Special Day Editor in I/NET.
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Your new entry should appear in the time schedule editor as seen 
below.

To tag a Day as Temporary

The spin dials in the I/NET time schedule editor allow you to tag any of 
the coming seven days as �Temporary�. When you tag a day as T1, I/
NET issues only the commands that are applicable to Temporary Sched-
ule 1. Days tagged as T2 will be issued only to those commands appli-
cable to Temporary Schedule 2. If you tag a day as Both, then both T1 
and T2 commands will be issued to the point.

Note

If you choose to use a temporary time schedule, for example T1, but 
you also want the normal time schedule for that specific day to be 
applied, then you will have to check the Temporary 1 checkbox in the 
Action Editor. A �Y� will be displayed in the T1 column for that nor-
mal day entry.

The same applies to Special Day schedules. If you choose to use a Spe-
cial Day schedule, for example S1, but you also want the normal time 
schedule for that specific day to be applied, then you will have to 
check the Special 1 checkbox in the Action Editor. A �Y� will be dis-
played in the S1 column for that normal day entry.
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18 Dial-up Communication

18.1 Dial-Up Communication Overview
Dial-Up communication means establishing communication between a 
Vista Server and the network and devices of a site. Modems are used to 
dial-up and initiate a path of communication in order to send data and 
alarms from the site to the Vista Server.

Dial-up communication from the site is automatically initiated, when 
you open a dialog box, window or pane in Vista Workstation to view 
values or alarms.

The dial-up connection is automatically disconnected (after a time out) 
when all dialog boxes, windows or panes displaying values or alarms 
has been closed.

A dial-up connection can also be initiated by a device to send alarms or 
data to a Vista Server. After the device has finished sending alarms or 
data the dial-up connection is closed (after a time out).

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Tip

Activate the auto-logout feature for all users in Vista systems that uses 
dial-up connections. The auto-logout will automatically log out any 
inactive users, closing any open all open dialog boxes, windows and 
panes in Vista Workstation.

This will prevent an inactive user from keeping a dial-up connection 
up and running.
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18.2 Monitoring a Dial-Up Connection in Progress
When a dial-up connection is in progress, this will be displayed in the 
lower right corner of the status bar of Vista Workstation.

A telephone icon is displayed along with texts explaining the status of 
the connection in progress:

� Initialization. Information about the Vista Server and modem, 
along with the initialization string for the modem, is displayed, for 
example VistaSRV_1-Modem1: Initializing (ATS12=1).

� Dialing. While dialing, the number of seconds remaining is dis-
played, for example: 
VistaSRV_1-Modem1:Dialing (Time left: 12 s).

� Error messages. If an error occurs, an error message will be dis-
played in the tooltip, for example Error 417 (No dial tone).

When the connection has been established, information about the 
modem/dial-up connection will be removed from the status bar.

To monitor a dial-up connection in progress

1 Look at the lower right corner of the status bar in Vista Worksta-
tion.

2 The status bar is automatically updated with information. If you 
have more than one modem, point to the telephone icon and a tool-
tip will display information about all the available modems/dial-
up connections.
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19 I/NET Features

19.1 The I/NET Host Tool

19.1.1 I/NET Host Tool Overview

Vista Workstation uses I/NET Seven as a tool for configuring I/NET 
objects. 

If I/NET�s I/O server is not already running on your workstation, 
launching the I/NET host tool causes the I/O server to load automati-
cally. In this case, an I/O server icon will appear in the system tray area 
of the Windows taskbar.

19.1.2 I/NET Licenses

The I/NET host tool provides a subset of the features that are found in a 
standard I/NET Seven system. The actual features provided by the  
I/NET host tool will depend on how I/NET is licensed in your Vista sys-
tem.

The following two types of I/NET licenses are available:

� Integrated � Provides basic I/NET system functions as well as 
functions associated with HVAC.

� Security � Provides basic I/NET system functions as well as 
functions associated with access control.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

The actual I/O server icon that appears in the system tray will depend 
on how your I/NET system is currently configured. Refer to your  
I/NET Seven documentation for a complete description of all I/O 
server icons.
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Licensed I/NET features

The following table lists the features that are available in TAC Vista 
Workstation for each type of I/NET license. The table also includes fea-
tures that are common to both licenses. It is possible to have one, both, 
or neither license. 

Table 19.1: Licensed I/NET Features 

I/NET 
License

Feature Provided

Either 
license

The following features are common to both types of I/NET licenses. 
System features:

� Change password
� Connect/disconnect
� Logon/logoff

� Quit
� Work offline

Host features:

� Host configuration editor
� Host password editor
� Host phone numbers editor
� Host software restore editor

� Netcon function editor
� Network configuration editor
� System view

Tap features:

� Host, link, and site tap configuration
� Site tap remote configuration

� Site tap save/restore

Controller features:

� 7720 configuration editor
� Action messages summary
� Alarm extension editor
� Calculation editor
� Control description editor
� Conversion coefficient editor
� DCU configuration editor
� DCU save editor
� DCU restore editor
� DCU password editor
� DPU configuration editor
� Engineering units editor
� Event extension editor
� Event sequences summary

� I1/I2 stat parameters editor
� Lighting circuits editor
� Lighting zones editor
� LCD page definition editor
� Lookup table editor
� MCU configuration editor
� MR configuration editor
� Resident point editor
� Special days editor
� State descriptions editor
� Time schedule extension editor
� Trend extension editor
� Trend plot view dialog box

Summaries:

� Configuration summary
� Controller summary

� Disabled points summary
� Off-normal points summary

Reporting features:

� SevenReports (operates in view-only mode if no I/NET CD key is installed)
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Integrated The following features are only available with the �Integrated� I/NET license. 
Controller features:

� Consumption extension editor
� DDC modules summary
� Demand control extension editor
� MR DDC Summary
� Override billing equipment map-

ping editor
� Override billing extension editor

� Override billing parameter editor
� Runtime extension editor
� Temperature control extension editor
� Unitary control configuration editor
� Unitary control extension editor

Security The following features are only available with the �Security� I/NET license. 
Controller access features:

� Elevator extension editor
� DCU AIC editor
� Door extension editor

� Personnel schedules
� SCU parameters editor

Host access features:

� Access control options editor
� Access control wizard
� AIC editor
� Door extension editor
� Groups editor
� Individuals editor
� Key translation editor

Summaries
� Door tenant summary

� Personnel schedules
� Pin generation dialog box
� Recycle bin
� SCU editor
� Tenant editor
� User search

Table 19.1: Licensed I/NET Features (Contd.)

I/NET 
License

Feature Provided
TAC AB, Nov 2006 205 (246)
04-00022-01-en



19  I/NET Features TAC Vista Workstation, Operating Manual
19.1.3 Launch the I/NET Host Tool

There are two methods for launching the I/NET host tool:

� Application method - When you manually launch the I/NET host 
tool from Vista Workstation�s main menu, it launches as an appli-
cation with all of the functions applicable to the installed license.

� Point-sensitive method - When you edit an I/NET object in Vista 
Workstation, the I/NET host tool automatically launches as a 
background task (that is, the main window is hidden) in order to 
display the appropriate I/NET editor.

To launch the I/NET host tool as an application

1 On the Tools menu, click TAC I/NET Host Tool.

2 If I/NET Seven is configured to automatically log you in using 
your Windows �user� account, the I/NET host application opens 
ready to use. Otherwise, you are presented with a login dialog box.

Login by typing a valid Operator Name and Host Password, and 
selecting OK.

To launch a point-sensitive I/NET editor

1 In the folder pane, locate the desired I/NET system point. Expand 
each branch of the I/NET point until the point type portion of the 
point is visible. See Section 19.2, �I/NET Points�, on page 207 for 
an example.

2 Right-click the I/NET point, select Edit, and then select an avail-
able function. The I/NET host tool launches the appropriate I/NET 
editor.
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19.2 I/NET Points

19.2.1 I/NET Points Overview

I/NET points reside in the controllers that connect to the I/NET net-
work. They are either external points such as a temperature sensor, 
internal points such as a calculation, or indirect points such as a com-
mon outside air temperature among controllers. 

19.2.2 I/NET Point Types

� Analog input (AI) points � AI points sense a variable and convert 
the input from current or voltage (analog value) to counts and then 
to a displayed value. It differs from a DI point in that it senses a 
value (such as 72 degrees) rather than a binary condition of one of 
two possible states.

� Analog output (AO) points � AO points also encompass pulse 
width modulated (PWM) outputs. AO and PWM outputs both use 
analog point processing. In I/NET, if you have a 7700, 7716, 7718, 
7756, MR123-032MB, MR632, or 7728 I/SITE I/O controller, you 
have the option of using true AO points or PWM points. All other 
controllers provide only PWM points. 

A true AO point uses a digital-to-analog converter to convert 
counts to analog signals. Typically the output, either 4�20 mA or 
0�10 VDC, is used to reposition a device such as a valve actuator 
or damper operator.

A PWM point does not use a digital-to-analog converter. In terms 
of the hardware, a PWM output point is really a DO point operating 
with AO point processing. As the value of the PWM point varies, 
so does the pulse duration of the hardware output.

� Digital input (GI) points � This is a specialized DI point that 
requires the use of eight consecutive bit offset addresses. Only the 
first address (typically bit offset = 00) is defined in the database. 
The location of these addresses varies depending on the type of 
controller.

Digital input points create an equipment value based on the state of 
eight contacts using one point address and all eight of its associated 
bit offsets (values 00�07). Depending on the bit or bits energized, 
an equipment unit value, called �counts�, is produced.

Digital Input Conversion � The equipment unit value ranges from 
0 to 255 (see table below). Equipment values are additive. For 
example, all contacts open results in an equipment unit value of 
zero (0); all contacts closed results in an equipment unit value of 
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255; contacts 00, 01, and 07 energized results in an equipment 
value of 131 (1 + 2 + 128 = 131).

� Digital output (GO) points � A GO point is a specialized DO 
point that, like the GI point type, requires eight consecutive point 
addresses.

As with the GI point, only the first address is defined. The next 
seven hardware inputs and addresses are not defined; however, 
they cannot be used for any other purpose. The point addresses for 
GO points vary by controller. On some controllers, these addresses 
will have the same point portion (PP), with bit offsets (BB) 00�07. 
On other controllers, the point portion (PP) will be different, and all 
bit offsets (BB) will be 00. Refer to your I/NET Seven documenta-
tion for GO point addressing for specific controllers.

Digital output points energize up to eight consecutive discrete out-
put points, based on an equipment unit value (X). Engineering unit 
value (Y) is converted to equipment unit value (X) using conver-
sion coefficients.

Digital Output Conversion � The equipment unit value, called 
�counts� (X), ranges from 0 to 255. Calculation of the slope (m) 
and Y-intercept (b) is identical to that for an analog output point 
driving a D/A converter, except the equipment unit value (X) deter-
mines which of the 8 discrete outputs will be energized (see the 
table below). Equipment values are additive. For example, if the 

Table 19.2: Digital Input Equipment Unit Values

Point Address (bit offset) Equipment Unit Value

00 1

01 2

02 4

03 8

04 16

05 32

06 64

07 128
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equipment unit value (X) is 75, discrete outputs 1, 2, 4, and 7 are 
energized (1 + 2 + 8 + 64 = 75).

� Discrete alarm (DA) points � This is a specialized DI point. Use 
it when you want to be aware of an alarm condition sensed by a 
contact opening/closing. Multiple contacts may be monitored for 
up to eight states for the point. For a binary (two-state) point, the 
two states of a DA point are NORMAL and ALARM. You deter-
mine which state (0 or 1) is �normal�. This point may be super-
vised (monitored for shorts or breaks in the line).

� Discrete input (DI) points � DI points sense the state of a contact 
that can be measured with single or multiple closures. The point is 
considered binary if it exists in one of two possible states: ON or 
OFF, OPEN or CLOSED, etc. The maximum number of states for 
a point is eight, which requires three contacts (bits). 

Typical DI points are flow verification (yes/no) on a fan or pump, 
high level float switch closure, or door switch (open or closed). 
This point type may be supervised (monitored for breaks or shorts 
in the line), but it will not produce an alarm indication.

� Discrete monitor (DM) and discrete control (DC) points � 
These points are always used in a pair. They control devices that 
would otherwise be controlled by an ordinary DO point but are 
considered critical enough to warrant a DM/DC combination. The 
DC point does the actual controlling (opening and closing of the 
hardware contact) and the DM point provides positive feedback 
from an external discrete device (for example, an air flow switch).

The DM point is typically wired to a proof-of-flow switch that tran-
sitions when the controlled device is started or stopped. It may also 
be used to monitor an auxiliary contact on a motor starter if a 
proof-of-flow switch is not installed. However, used in this way, 
the only information you are really receiving is that the contacts 

Table 19.3: Digital Output Equipment Unit Values

Equipment Unit Value Discrete Output Energized

1 1

2 2

4 3

8 4

16 5

32 6

64 7

128 8
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have closed or opened, but not whether the device is actually run-
ning. 

The DC point senses deviation between the commanded state and 
the monitored state, and provides an alarm if the controller com-
mands the DC point ON or OFF and the DM point does not transi-
tion. The DC point also generates an alarm if an external force 
alters the state of the DM input point and the output point was not 
changed; for example, an operator using a �Hand-Off-Auto� 
switch.

� Discrete output (DO) points � DO points control the state of 
binary outputs. These points are typically used for turning devices 
such as fans, pumps, and lights on and off. DO points are also used 
for door-related points (door strike) if you are using access con-
trol. I/NET door points always use bit offset addresses of 08 or 09.

� Pulsed input (PI) points � PI or accumulator points accumulate 
pulses from the data environment and convert them into engineer-
ing unit values. External PI points are capable of accepting pulses 
from such devices as electric demand pulse meters, flow meters, 
or other devices that convert a flow to a pulsed output. Internal 
accumulators can accumulate not only pulses but analog values as 
well, and in the case of an integrating accumulator, can convert an 
instantaneous rate input into a total value.
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19.2.3 Viewing I/NET Points

I/NET points associated with a Xenta 527 Server are accessible from the 
folder pane in TAC Vista Workstation. When you select an I/NET point 
in the folder pane, point-specific functions become available. Your abil-
ity to access and use these functions will depend on whether or not the 
I/NET host tool is installed and how it is licensed. For more information 
on licenses, see Section 19.1.1, �I/NET Host Tool Overview�, on 
page 203.

To view I/NET Points

� Using the following graphic as an example, locate and expand 
branches in the folder pane to expose I/NET points and their sub-
ordinate objects.

This example shows the point type portion of I/NET point 
55220003 DC highlighted in the folder pane. For more information 
on point type, see Section 19.2.1, �I/NET Points Overview�, on 
page 207.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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19.2.4 Selecting an I/NET Point

Many of the I/NET-related tasks that you can perform in Vista Work-
station require that you first locate and select an I/NET point.

To select an I/NET point

1 In the folder pane, expand the Xenta 527 server and locate the  
I/NET object.

This object is a container for I/NET points, point extensions, and 
configuration objects.

2 Expand the I/NET object and its underlying branches until the 
point type portion of the desired I/NET point is visible.

3 Click on the point type portion of the I/NET point. 

The following example shows I/NET point 55220003 DC selected 
in the folder pane. 

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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19.2.5 Using Point-specific Features

To open point-specific HTML pages

1 Expand the point type portion of an I/NET point to view its avail-
able HTML pages.

2 Select an HTML page to open it in Vista.

To open point-specific I/NET editors

1 Right-click on the point type portion of an I/NET point and select 
Edit.

2 Select a function to launch its associated I/NET editor.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

I/NET editors are only available from within Vista Workstation when 
its configuration includes the I/NET host tool.
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19.2.6 Controlling an I/NET Point

In order to control an I/NET point from Vista, you must first open its 
point control editor. Vista provides an HTML-based editor for this pur-
pose. 

If your configuration of Vista Workstation includes the I/NET host tool, 
you also have the option of using I/NET's point control editor.

To control an I/NET point

1 In the folder pane, locate the desired I/NET system point. Expand 
each branch of the I/NET point until the point type portion of the 
point is visible. See Section 19.2, �I/NET Points�, on page 207 for 
an example.

2 Open the point�s �Point Control� HTML page or launch I/NET�s 
point control editor. If necessary, refer to �Using Point-specific 
Features�, above, for instructions. 

3 With the Point Control editor open, control an I/NET point using 
the following functions:

� Control State � This drop-down list allows you to select a 
control state for manual control of both input and output 
points. The list contains the state descriptions defined in 
I/NET�s State Descriptions Editor. The control commands 
that are actually sent to the point are defined in I/NET's Con-
trol Descriptions Editor.

� Download � Use this function to download the selected con-
trol state to the point.

� Test On/Test Off � Allows you to toggle the point between 
the two options (test mode �ON� or test mode �OFF�). Use 
the Test mode to isolate one or more points from external 
hardware. This allows you to verify controller operation for 
selected points without affecting or using the external hard-
ware. This also allows you to manually enter states/values for 
points.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Note

While using the Test mode, the controller continues to update the data-
base for the selected point. Your states/values for the point can be 
overridden by the controller. To prevent the controller from overriding 
you states/values, also place the point in Manual mode.
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� Manual/Automatic � Allows you to toggle the point between 
the two options (manual mode or automatic mode). Manual 
mode disables all automatic functions from controlling the 
external hardware (that is, ATS, DDC, Demand, and so on).

� Alarm Ack � Allows you to acknowledge an alarm if the 
selected point is in alarm.

� Release � (Door Outputs only) Allows you to momentarily 
release the output strike for a door. 

� APB Reset � (Door Outputs only) Removes the anti-passback 
flags from the select door and any other doors within the same 
zone as the selected door. Use of this command causes I/NET 
to generate an audit trial message. Refer to Resetting the 
Anti-Passback Flag for more information.

Note

While a point is in the Manual mode, the state/value you enter is also 
sent to the connected hardware.
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19.2.7 Setting a Point’s Message Routing Parameters

To configure a point’s routing parameters for 
alarms/messages

1 In the folder pane, locate the desired I/NET system point. Expand 
each branch of the I/NET point until the point type portion of the 
point is visible. See Section 19.2, �I/NET Points�, on page 207 for 
an example.

2 Open the point�s �Alarm Configuration� HTML page or launch  
I/NET�s alarm configuration editor. If necessary, refer to 
Section 19.2.5, �Using Point-specific Features�, on page 213, for 
general instructions.

3 Choose a Distribution Group.

This will determine which set of 8 masks will be used for compar-
ison at I/NET�s Tap or host level.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

HTML-based editor

I/NET editor
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4 Define the Distribution Mask. Activate or deactivate any of eight 
mask positions.

When a message is generated from the I/NET point, each of the 
point�s mask positions gets compared to corresponding mask posi-
tions in the host or Tap. If any corresponding mask positions are 
activated at both the point level and Tap/host level, the 
point-related message data will be transmitted.

5 Choose a Message Priority setting. This setting controls when 
messages will be sent to the host computer.

6 Choose an Alarm Priority setting. This setting controls when 
alarms will be sent to the host computer.
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19.3 I/NET Point Extensions

I/NET point extensions allow you to add pre-defined special functions 
to I/NET points. Not all point extensions are available for every I/NET 
point type. The following table shows the general function of each 
extension, and the point types which may use that extension.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.

Table 19.4: I/NET Point Extensions 

Point 
Extension

Description
I/NET Point 

Types

Alarm Inhibit Prevents nuisance alarms that may occur when a piece of 
equipment is off.

AI, DA, DM, GI

Calculation Defines calculations on points to expand the capability of the 
controller or provide information that cannot be obtained from 
a sensor.

All point types 

Consumption Directs the accumulated value of a PI point to a particular con-
sumption cell for storage. Also zeroes the value stored in the 
DCU for the PI point at midnight.

PI

Demand  
Control

Monitors PI points for electrical power consumption, predicts 
demand, and maintains daily and monthly power consumption 
totals. Includes load shedding capability (ability to control 
points off). Not available on 7750, 7770, 7780, or 7791 con-
trollers

PI

Elevator Sets access parameters for elevators. May only be used for 
door points (bit offset BB 08 or 09) defined as elevators. Each 
elevator will have associated DO (floor relay) and DI (floor 
selection button) points. This extension is only available in the 
7791 DPI, 7793 MCI and 7798 I/SITE LAN

DO

Event  
Definition

Specifies a certain condition (event) and the response that con-
dition initiates (event action or event sequence). Events are 
limited to specific point types.

All point types

Lighting  
Control

Controls lighting points by zone. Lighting control may be a 
cycle or a time schedule. This extension is only available in the 
7780 DLCU.

DO

Override  
Billing

Allows you to use the 7750 Building Manager, with dial-in 
access, to control points residing in other controllers. This 
extension is only available in the 7750 DCU.

DO

Runtime Defines runtime parameters for a discrete point (input or out-
put) so that runtime information can be collected for Docu-
trend SevenTrends reports.

DC, DI, DO 
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Temperature Control Controls output points managing HVAC units. Also provides 
optimized start/stop, night setback/setup control, and demand 
temperature override control.

DC, DO

Trend  
Sampling

Sets parameters for recording data from this point for graphs or 
Docutrend SevenTrends plots.

All point types

Time  
Scheduling

Controls output points according to the schedule entered. DC, DO

Table 19.4: I/NET Point Extensions (Contd.)

Point 
Extension

Description
I/NET Point 

Types
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19.3.1 Edit an I/NET Point Extension

TAC Vista Workstation provides an HTML-based point extension edi-
tor for adding and editing two kinds of I/NET point extensions: time 
schedules (for DO and DC points only) and trend samples.

If your configuration of Vista Workstation includes the I/NET host tool, 
you also have the option ofadding and editing any type of I/NET point 
extension using I/NET�s point extension editors.

To edit an I/NET point extension

1 In the folder pane, locate the desired I/NET system point. Expand 
each branch of the I/NET point until the point type portion of the 
point is visible. See Section 19.2, �I/NET Points�, on page 207 for 
an example.

2 If you are editing a time schedule or trend sample extension, you 
can use the point�s Time Schedule or Trend Configuration 
HTML page, respectively. Alternatively, you can launch I/NET�s 
point extension editor for all types of point extensions.

If necessary, refer to Section 19.2.5, �Using Point-specific Fea-
tures�, on page 213, for general instructions.

3 If the point extension that you are attempting to edit has not 
already been added to the selected point, you will receive a mes-
sage asking if you would like to add the extension now. Click Yes 
to add the extension to the point.

4 In the point extension editor, use the available fields and options to 
edit the extension.

5 When you have finished editing the point extension, click OK.

Advanced

The following information applies to complex tasks or tasks restricted 
by access.
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19.4 I/NET Alarms, Messages, and Transactions
I/NET alarms, messages, and transaction can be viewed from within 
Vista Workstation. You can view these items from any alarm or event 
pages that may have been added to the Xenta 527�s project, or from 
dynamic alarm and transaction viewers that are built into Vista. The 
information in this section describes Vista�s dynamic viewers.

19.4.1 Viewing I/NET Alarms and Transactions

To view I/NET alarms and transactions

1 Near the top of the folder pane, locate three alarm objects (for crit-
ical, priority, and routine I/NET alarms) and one transactions 
object.

2 Click the Critical Alarms object. Critical I/NET alarms are dis-
played in Vista.

3 Click any of the other objects to view other types of alarms or 
transactions.

Note

The time it takes for Vista�s dynamic alarm and transaction viewers to 
open is dependant on the number of messages active in the system.
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19.4.2 Acknowledging I/NET Alarms

To acknowledge I/NET alarms

1 In the dynamic alarm viewer, highlight one or more I/NET alarms.

2 Acknowlege the alarm(s) using any of the following methods:

� Click the Acknowledge icon ( ) in the toolbar.

� Press F9.

� Right-click on any highlighted alarm and select Acknowl-
edge.

3 Verify that the selected alarm(s) change to an acknowledged state 
in the alarm viewer.

19.4.3 Purging I/NET Alarms

To purge I/NET alarms

1 In the dynamic alarm viewer, highlight one or more I/NET alarms.

2 Purge the alarm(s) using either of the following methods:

� Click the Purge icon ( ) in the toolbar.

� Right-click on any highlighted alarm and select Purge.

3 Confirm that you wish to purge the selected alarm(s). Select Yes to 
confirm one alarm at a time, or select Yes to All to confirm all 
selected alarms.

4 Verify that the selected alarm(s) are purged from the alarm viewer.
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19.4.4 Filtering Alarms

To filter alarms

1 On the toolbar, click Filter (  ).

2 In the Alarm Filter dialog box, click appropriate tab and specify 
your filter options.

3 Click OK.
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20 Trend Log Profiles

20.1 Temperature per hour

This profile is used for logging indoor or outdoor temperatures once an 
hour.

Logging will start immediately after you have finished the trend log 
wizard, and will continue to log the temperature once an hour at the 
same time. The log is a circular one that logs the values for 106 weeks, 
before starting over.

A trend chart is created which displays the logged temperature.

Fig. 20.1: Log Profile: Temperature per hour
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20.2 Average Temperature per day

This profile is used for creating an average temperature for each day 
(24 hours).

Logging will start immediately after you have finished the trend log 
wizard, and will continue to log the temperature once an hour at the 
same time. The log is a circular one that logs the values for 106 weeks, 
before starting over.

A trend log calculations is created to save the average day temperature.

A trend chart is created which displays the average daily temperature.

Fig. 20.2: Log Profile: Average Temperature per day
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20.3 Heating per 24 hours (before midnight)

This profile is used for logging heating (energy usage) once a day 
(24 h).

The profile is intended for logging the usage of the current day, and log-
ging takes place 5 minutes to midnight. The log is a circular one that 
logs the values for 106 weeks, before starting over. The daily values are 
stored in the trend log.

A trend log calculation is created to save the usage per month.

No trend chart is automatically created.

Fig. 20.3: Log Profile: Heating per 24 hour (before midnight)
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20.4 Heating per 24 hours (after midnight)

This profile is used for logging heating (energy usage) once a day 
(24 h).

The profile is intended for logging the usage of the previous day, and 
logging takes place 5 minutes past midnight. The log is a circular one 
that logs the values for 106 weeks, before starting over.

To ensure the logged value is stored on the correct day, a trend log cal-
culation object is also used. A second trend log calculation is used to 
save the usage per month.

No trend chart is automatically created.

Fig. 20.4: Log Profile: Heating per 24 hours (after midnight)
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20.5 Electricity per hour

This profile is used for logging the hourly consumption of electricity.

Logging will start immediately after you have finished the trend log 
wizard, and will continue to log the usage of electricity once an hour at 
the same time. The log is a circular one that logs the values for 106 
weeks, before starting over.

A trend chart is created which displays the logged usage.

Fig. 20.5: Log Profile: Electricity per hour
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20.6 Electricity per 24 hours (before midnight)

This profile is used for logging electricity consumption (energy usage) 
once a day (24 h).

The profile is intended for logging the usage of the current day, and log-
ging takes place 5 minutes to midnight. The log is a circular one that 
logs the values for 106 weeks, before starting over.

The daily values are stored in the trend log. A trend log calculation is 
created to save the usage per month.

No trend chart is automatically created.

Fig. 20.6: Log Profile: Electricity per 24 hours (before midnight)
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20.7 Electricity per 24 hours (after midnight)

This profile is used for logging electricity consumption (energy usage) 
once a day (24 h).

The profile is intended for logging the usage of the previous day, and 
logging takes place 5 minutes past midnight. The log is a circular one 
that logs the values for 106 weeks, before starting over.

To ensure the logged value is stored on the correct day, a trend log cal-
culation object is also used. A second trend log calculation is used to 
save the usage per month.

No trend chart is automatically created.

Fig. 20.7: Log Profile: Electricity per 24 hours (after midnight)
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20.8 Water per 24 hours (before midnight)

This profile is used for logging water consumption (usage) once a day 
(24 h).

The profile is intended for logging the usage of the current day, and log-
ging takes place 5 minutes to midnight. The log is a circular one that 
logs the values for 106 weeks, before starting over.

The daily values are stored in the trend log. A trend log calculation is 
created to save the usage per month.

No trend chart is automatically created.

Fig. 20.8: Log Profile: Water per 24 hours (before midnight)
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20.9 Water per 24 hours (after midnight)

This profile is used for logging water consumption (usage) once a day 
(24 h).

The profile is intended for logging the usage of the previous day, and 
logging takes place 5 minutes past midnight. The log is a circular one 
that logs the values for 106 weeks, before starting over.

To ensure the logged value is stored on the correct day, a trend log cal-
culation object is also used. A second trend log calculation is used to 
save the usage per month.

No trend chart is automatically created.

Fig. 20.9: Log Profile: Water per 24 hours (after midnight)
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20.10 Carbon Dioxide (CO2) every 10 minutes

This profile is used for the level of carbon dioxide (CO2). Logging will 
start immediately after you have finished the trend log wizard, and will 
continue to log the level of carbon dioxide every 10 minutes.

A trend chart is created which displays the logged carbon dioxide level.

Fig. 20.10: Log Profile: Carbon Dioxide every 10 minutes
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20.11 Log a Generic Value every 10 Minutes

This profile is for logging a generic value (that is any value) every 10 
minutes.

The log is a circular one that logs the values for 8 weeks, before starting 
over. A trend chart is created which displays the logged values from the 
trend log. 

Fig. 20.11: Log Profile: Log a Generic Value every 10 minutes
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